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Introduction
Welcome to the exciting world of print creativity! PrintMaster Gold makes it easy to produce beautiful projects you’ll love to show 
around. Simply choose from PrintMaster Gold’s selection of beautiful, ready-to-print designs, make any changes you want, and 
you’re ready to print. It’s really that easy!

In this Online User's Guide, we've include 12 Chapters to help you get up and running fast. Below is a brief descripton of each 
chapter. After you find the chapter you want, open it by clicking on the chapter popup window at the bottom left of this screen, or 
select the chapter from the Contents menu above. Then you can either read the chapters online, or print them out.

PrintMaster Gold Features
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The PrintMaster Ready-Made Gallery
Choose from thousands of Ready-Made projects ideal for both home and business—greeting cards, banners, signs, calendars, 
certificates, stationery, business cards, labels, newsletters and many more. And don’t forget, any design can be quickly personalized 
with your choice of text and graphics—even your own photos.
With-Help Designer
Not ready to start from scratch? The With Help Designer is the best place to start. Our fully-trained print designer will help you 
personalize greeting cards, posters, and letterhead in a few easy steps.
Advanced Rendering Technology
PrintMaster Gold provides 24-bit rendering that supports over 16 million colors or shades of gray in the highest resolution possible 
on your printer. Whether you own a color or black & white printer, you’ll always get fabulous printouts that are guaranteed to get 
noticed!
Address Book
The PrintMaster Gold Address Book makes mail merging easy. Print holiday cards for all your relatives or labels for your 
customers—all with one easy command. Available in PrintMaster Gold Publishing Suite only.
Thousands of Gorgeous Graphics
The thousands of paintings, drawings, cartoons, photos, and watercolors—many made specially for PrintMaster Gold—will spice up 
any project. And since PrintMaster Gold works with all popular graphic formats, you can use clip art images from any source—even 
your own scanned images.
Fabulous Fonts
Communicate clearly and effectively with the most complete library of professional- quality TrueType fonts ever offered. Every font 
can be stretched and scaled to any size you want—from a miniature greeting card to a gigantic garage door poster. You can also add 
your choice of special effects to any font selection for unlimited variety.

                     Table of Contents
 

This is Chapter one. It gives you an overview of the features in PrintMaster Gold, this Table of Contents, and Licensing information.
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Installing PrintMaster Gold is quick and easy. Follow the steps listed in this chapter and in a few moments you’ll have PrintMaster 
running smoothly. This chapter also includes information on registering your copy of PrintMaster Gold and setting your Workspace 
preferences.

 

As soon as you open the program, you’ll notice PrintMaster Gold has several interrelated areas, each with it’s own individual 
purpose and look. Each area--including the Hub, Art Gallery, With Help Designer, and Workspace--offers you different tools to help 
create a unique card, calendar, or newsletter. This chapter introduces you to each PrintMaster Gold area and describes the buttons 
and menus for each.

 

To get your feet wet, we’ve included several fun Tutorials for you to follow. This chapter includes the step-by-step information on 
creating Card and Photo Projects. Each project tutorial shows you how to work with art, sentiments, and add-on products, as well as 
the different PrintMaster Gold work areas.

 

This chapter includes step-by-step instructions on creating Newsletter, Label, and Calendar projects, as well as instructions on 
creating your own Address Book.

 

This chapter introduces you to many of the other projects available that are not included in the Tutorials, including Matching Sets, 
Banners, Note Cards, Newsletters, and many more

 

User's Guide Page  3 Die, 5. Jul 2016
Chapter 1: Introduction



PrintMaster also makes it easy to get on the Internet. In this version of PrintMaster Gold, we’ve included two new utilities to help 
you browse the World Wide Web and send online greeting cards to your friends: PrintMaster Gold’s Online Greetings and the 
AT&T WorldNet Service. Read this chapter to learn more. Note: these add-on products are only in PrintMaster Gold Publishing 
Suite and PrintMaster Gold Deluxe.

 

Great-looking text can make the difference between getting read and being ignored. With PrintMaster Gold you can choose from a 
rich palette of text editing commands that let you modify any selected text with your choice of fonts, sizes, shapes, colors, and 
exciting effects.  This chapter provides step-by-step instructions that describe all aspects of working with text in PrintMaster Gold: 
adding text to your projects, editing text, changing text size and appearance, setting tabs, and linking text boxes.

 

PrintMaster Gold makes it easy to add pictures and shapes to your projects. You can have as many pictures or shapes as you like, and 
they can be resized or arranged anywhere you want on the page. Read this chapter to learn about all the picture manipulating and 
adjusting tools available in PrintMaster Gold.

 

No matter how good your project looks on the screen, the final printout on paper is what really counts. PrintMaster Gold pulls out 
all the stops to make sure your printed project will look its best. PrintMaster Gold has full 24-bit rendering that supports more that 
16 million colors or shades of gray which means your pictures will look spectacular. This section provides step-by-step instructions 
for printing your project and optimizing your printing setup.

 

Before you call Technical Support, here are a few helpful hints for uncovering problems. We've also included a list of the 
most-used key combinations so you can work faster.
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In case you have a problems, we offer you several different ways to contact us for answers. Please read this chapter before contacting 
Technical Support. 

Notice
This publication contains proprietary information that is protected by copyright laws. All rights are reserved. No part of this 
publication may be reproduced, photocopied, stored in an information retrieval system, or transmitted, in any form or by any means 
without prior written permission of Mindscape.

Although every precaution has been taken in the preparation of this document, Mindscape makes no warranty of any kind with 
regard to the use of this material, including, but not limited to, the implied warranties of merchantability and fitness for a particular 
purpose. No patent liability is assumed with respect to the use of the information contained herein.

Copyright © 1997 Mindscape, Inc.
All rights reserved.
PrintMaster Gold™ is a trademark of Mindscape, Inc.
Macintosh is a registered trademark of Apple Computer, Inc.
All other trademarks and registered trademarks are the property of their respective holders.

License Agreement
By using the software included with this agreement you accept the terms of the license with Mindscape. If you do not agree to the 
terms of this agreement, and you are the original purchaser of this program, promptly return the software together with all 
accompanying items to the point of purchase for a refund.

Copyright
This software is owned by Mindscape, Inc. and is protected by United States copyright laws and international treaty provisions. You 
must treat the software like any other copyrighted material.
You may not copy the written materials accompanying the program, nor make copies of the program or any part thereof.

Single User License
Mindscape, Inc., as Licensor, grants only to you, the Licensee, a non-exclusive right to use the enclosed software on one single 
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computer (CPU) at one single location.
You may not install this software on networks, sublicense, loan, rent, or otherwise distribute this software for use by others. You 
may be held legally responsible for any copyright infringement that is caused or encouraged by your failure to abide by the terms of 
this license.

Performance Guarantee
All Mindscape products are guaranteed to perform as advertised. However, Mindscape’s entire liability and your exclusive remedy 
shall be at Mindscape’s option either (a) return of the product for refund of purchase price or (b) replacement of the software.
This guarantee is void if the failure of the program has resulted from accident, abuse, misapplication, or use of the program with 
incompatible hardware.
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   Getting Started
Before installing, check the system requirements listed below to make sure your computer is able to work with PrintMaster Gold.

System Requirements
PrintMaster Gold performs on any computer with the following features:
• An Apple® MacintoshTM computer or compatible (Macintosh 68030 33 MHZ or PowerPC)
• System 7.5 operating system or higher. System 7.6 or higher required for Online Greetings
• 8 MB of RAM (virtual memory on); 16 MB recommended
• 20 MB of available hard-disk space
• Double-speed or better CD-ROM drive
• Macintosh-compatible mouse
• Macintosh-compatible monitor; color monitor with 256 Color mode (Thousands of Colors or better recommended)
• Hayes or 100%-compatible modem (optional)

Printer Support: PrintMaster Gold provides the highest resolution output possible on all black & white or color printers supported 
by the Macintosh. Be sure you have enough color ink cartridges before printing. We suggest you print out your projects on the best 
paper (usually glossy) your printer will support.

Graphics Support: PrintMaster Gold provides a large selection of spectacular full color CGM, TIFF, PSD, and JPG images and works 
with all other popular graphic formats: PCX, TIF, GIF, BMP, and Kodak Photo CD.

Font Support: PrintMaster Gold includes a complete library of high quality TrueType fonts and will work with any other TrueType 
fonts that are installed in your System.

Installing PrintMaster Gold
1. Start your Macintosh computer.
2. Insert the PrintMaster Gold CD-ROM into the CD-ROM drive.
3. From the Finder, double-click on the PrintMaster Gold Installer icon.
+ NOTE: If you have less than 16Mb of RAM, virtual memory should be turned on for better performance. To turn virtual memory 
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on, select Memory in the Control Panel, then click ON. You will then have to restart your computer.
4. When the PrintMaster Gold start-up screen is displayed, click Continue or press RETURN. The Readme file is then displayed.
5. Click Continue. The install dialog box is displayed.
6. The location where PrintMaster Gold will be installed is displayed in the lower left corner of the dialog box. To change the folder 
or disk into which PrintMaster Gold will be installed, in click the pop-up menu and make your selection.
7. Press RETURN or click INSTALL to install PrintMaster Gold using the Easy or Custom options.
8. When the install is complete, click QUIT or press RETURN to exit the install process. 

Removing PrintMaster Gold
To remove an existing version of PrintMaster Gold from your computer:
     
1.  Drag the PrintMaster Gold Program folder to the trash.
2.  Drag "Run Remind" from the startup items to the trash.
3.  Drag the PrintMaster Preferences file (located in the Preferences folder) to the trash.
+ Note: Removing PrintMaster Gold will also remove any previous projects you have created in the PMW folder. If you would like 
to save these, please drag the document or Users folder to the desktop. 

Reinstalling PrintMaster Gold
Though unlikely, PrintMaster Gold files may become corrupted and the program may not run properly. If so, you can reinstall 
PrintMaster Gold, which cleans out all old files and restores original functionality.

1. Insert the PrintMaster Gold CD-ROM in your CD-ROM drive.
2. Double-click PrintMaster Gold Installer.
3. Follow the onscreen directions. PrintMaster Gold will reinstall all program and art files over the old files.
+ Note: Reinstalling will delete all of your stored projects in Your Own file.

Register for Free Bonus Fonts & Graphics
Registering your copy of PrintMaster Gold gives you: 69 Fonts & Graphics Free

PrintMaster Gold includes 69 designer fonts and 65 color graphics free. They are available when you enter a unique Registration 
Code given to you when you register your software. Once you unlock the fonts and graphics with the Code, they are automatically 
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added to your font and graphic galleries.

New Product and Upgrade Information
Every week, the PrintMaster Gold Team is creating new versions, new graphics, new Ready Mades, and new add-on products for 
PrintMaster Gold. Stay current with what’s happening in the world of print creativity—register soon!

To Register your program:
1. Double-click the PrintMaster Gold icon to start the program.
+ Note: In order to start PrintMaster Gold, the CD-ROM must be inserted into the CD-ROM drive.
2. Click the Free Fonts and Graphics button on the opening screen (or under the File menu).
3. If you have already registered (via mail) and just want to enable your free fonts and graphics, then type the Registration Code in 
the space provided and press RETURN or click OK.
 Otherwise, select the Click here to Register now! button.
4. Use your mouse to the pull down the menu and choose the country your are registering from.
5. Press RETURN or click OK to continue.
6. Select a method of registration by clicking the appropriate button:

Register by Modem
Select this method to register your PrintMaster Gold over a modem. Be sure that your modem is connected before selecting this 
option. If you need to dial a number to access an outside phone line, click the Dial Out Prefix button and type in the number.
• Type in your user information (Name, Address, etc.) and press Return or click OK to register. Your free fonts and graphics will 
automatically be enabled.

Register by Mail or Fax
Select this method to register your PrintMaster Gold by mail or fax. Be sure that your printer is online and ready before selecting this 
option.
• Type in your user information (Name, Address, etc.) and click Print Registration Form.

Adding your Personal Sender information
PrintMaster Gold can save you time if it knows your name and address. The first time you launch PrintMaster Gold, it will ask you 
for your name, return address, and other project information so your cards, letters, and envelopes can be filled-in automatically.
To add this data at a later time, select Sender Information under the Tools menu and fill in any of the fields.
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Performance
Since your hard disk is faster than your CD-ROM player, PrintMaster Gold improves performance by using a file on your hard disk 
to store the most frequently used information. This hard disk file is called the workspace file.

Workspace Preferences
To change the workspace size, click the File menu with your mouse, select Preferences, and choose Workspace.
Type in a new workspace size.
• A larger workspace uses more hard disk space but enables you to access fonts and graphics far more quickly.
• A smaller workspace uses less hard disk space but takes longer to access the fonts and graphics.
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The World of PrintMaster Gold
This section introduces you to the PrintMaster Gold environment. As soon as you open the program, you’ll notice PrintMaster Gold 
has several interrelated areas, each with it’s own individual purpose and look. Each area—including the Hub, Art Gallery, 
Sentiments Gallery, With Help Designer, and Workspace—offers you different tools to help create a unique card, calendar, or 
newsletter. If you are a new user, we suggest you first browse through the features in each area to get a basic understanding of the 
creative possibilities in PrintMaster Gold.

The Hub Screen
After you launch PrintMaster Gold, the first thing you will see is the Hub screen. The Hub is where you can choose the kind of help 
you want creating a project, choose to work on a Ready Made, view art in the Art Gallery, or launch your Internet browser and go to 
the PrintMaster Gold Web site.

Ready Made: Click here to view the Ready Made Gallery of projects created by the PrintMaster team of designers.
With Help: Click here to get step-by-step help from the PrintMaster With Help Designer.
Brand New: Click here to start any project from scratch.
Your Projects: Click here to go to your own Ready Made Gallery folder where you can view all the projects you’ve created.
Art Gallery: Click here to browse and choose any of the thousands of graphics, drawings, photos, and pictures in the Art Gallery.
Address Book: Click here to go to the Address Book where you can create your personal name and address list. Available only in 
PrintMaster Gold Publishing Suite.
Internet: Click here to launch your Internet Browser and go to the PrintMaster Gold Web site.
Free Fonts & Graphics: Clic here to register and receive free fonts and graphics.
Exit: Click here to quit the program.

Once you have decided on the type of project you would like to work on, click one of the buttons above to go there. You can always 
return to the Hub by closing the project you are working on, or clicking Back in the With Help windows.

The Workspace
The Workspace is your own personal drafting board, with all the text, drawing, and editing tools you’ll need to make a beautiful 
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project. Here, you can put the finishing touches on your project, add new pictures, type in your personal message, and print.
Below, we will introduce you to the main menu bar and the five toolbars in the Workspace. We suggest you browse through them 
to get an idea of the possibilities, then jump right in and start designing.

Menu Bar
Like most Macintosh applications, PrintMaster Gold has a menu bar at the top of the screen. The menu bar provides access to all 
PrintMaster Gold command features, including File, Edit, View, Format, and other functions.

Use your mouse to pull down these menus to see their contents. (See the Appendix entitled: Key Combinations later on in this 
guide for information on time-saving keyboard shortcuts).

The Global Toolbar
The Global toolbar, which is displayed across the top of the Workspace, provides quick mouse access to some of the most commonly 
used PrintMaster Gold actions such as closing the current project, going to the Ready Made Gallery, starting a With Help project, and 
starting a Brand New project. These buttons are also one-step alternatives to using the menu bar for saving, printing, viewing Print 
Preview, Cutting, Pasting, and others. To hide or display the Global toolbar, access the View menu, then Toolbars/Global Bar. 

Close: Click here to return to the Hub.
Ready Made:   Click here to go to the Ready Made Gallery.
With Help: Click here to go to the With Help Designer, where you will be prompted, step-by-step, to create your own personalized 
project.
Brand New: Click here to start a new project from scratch.
Save: Click here to save the current project. If you have not already provided a file name for your project, you will be prompted to 
do so at this point.
Print:   Click here to send your project to your printer.
Print Preview:   Click here to preview your project before printing.
Cut:   Click here to remove the selected text and/or graphic to the Clipboard.
Copy:   Click here to copy the selected text and/or graphic to the Clipboard.
Paste:   Click here to insert a copy of the Clipboard contents into your project.
Undo:   Click here to quickly undo changes in editing, formatting, and other actions. To quickly undo multiple actions, click here 
more than once.
Redo:  Click here to reverse changes made using the Undo button.
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Select Previous Object:   Click here to select the object in the previous layer.
Select Next Object:   Click here to select the object in the next layer.

Text Toolbar
The Text toolbar is where you can make adjustments to the text in your project. Notice that whenever you click on text in your 
project, the Text toolbar will be immediately updated. You can also use this toolbar to bold, italicize, stretch, bend, or align your text. 

To hide or display the Text toolbar, access the View menu, then Toolbars/Text Bar.

Font: Shows the name of the font that is currently selected.
Font Size:  Shows the size of the font that is currently selected.
Bold, Italic, and Underline: To make any character bold, italic, or underlined, highlight the character and click on the appropriate 
button.
Text Shape: Click here to select one of many shapes for your text. Note: your text shape selection will affect all of the text in the 
active text box.
Stretch Text: This option is great for large text. Click here to have PrintMaster Gold automatically adjust the text size to fill the limits 
of a text box.
Flush Left Alignment: Align the text in a paragraph to the left side of the text box.
Center Alignment: Align the text in a paragraph to the center of the text box.
Flush Right Alignment: Align the text in a paragraph to the right side of the text box.
Justified Alignment: Stretch the text so it aligns to both the right and left sides of the text box.

Add Toolbar
The Add toolbar holds all the supplies you need to add graphics, sentiments, and your own art to your project. Sentiments Available 
only in PrintMaster Gold Publishing Suite.
To hide or display the Add toolbar, access the View menu, then Toolbars/Add Bar.

Add A Picture: Click here to go to the PrintMaster Art Gallery. In the Art Gallery, you can choose from thousands of graphics, 
pictures, photos, and borders for your project. Double-click a picture preview in the Art Gallery and your selection will be placed on 
your project in the Workspace.
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Add a Sentiment: Click here to view the thousands of fun, sentimental, warm, and serious sentiments we’ve gathered in the 
Sentiments Gallery. Search by type or keyword for the sentiment you want, then select the sentiment and it will be inserted into 
your project automatically. Available only in PrintMaster Gold Publishing Suite.
Text Box: Click here to add text to your project. After clicking this button, your cursor will turn into a ‘text’ crosshair. You can then 
either drag (with the mouse button down) across the project to create a text box , or just click once on the project and start typing.
Line: Click this tool to draw a straight line on your project. To keep your line either horizontal, perpendicular, or at a 45-degree 
angle, hold down the Shift key while you drag the cursor across your project.
Rectangle: Use this tool to create a rectangle on your project. By holding down the Shift key, your box will be held to a perfect square.
Ellipse: Use this tool to create an ellipse. By holding down the Shift key, you your drawing will be held to a perfect circle.
Shape: Click on this tool to view a wide selection of shapes you can place on your project. Once you have selected a shape from the 
pop-up menu, drag your cursor across the project to determine its size. You can keep the shape’s original proportions by holding 
down the Shift key while you drag.
Free Draw: This tool acts like a pencil, letting you draw any design or line you want on your project. You can modify the width of 
the Free Draw tool with the Line Width tool in the Modify toolbar.

Modify Toolbar
Use the Modify toolbar to make adjustments to your art and text. With these tools, you can easily change the color of text and 
pictures, change line widths, add shadows, and crop pictures. 

To hide or display the Modify toolbar, access the View menu, then Toolbars/Modify Bar.

Color: Use this tool to add color to your pictures and text. First select the picture or text you want to color, then select this tool. You 
will then see a selection of colors to choose from.
Line Width: Use this tool to change the line width of your drawing or the outside border of a shape.
Line Color:Use this tool to change color of the border line of a picture.
Shadow: Use this tool to add a shadow to your text or shapes.
Shadow: Color Use this tool to choose the color of the shadow you placed behind your text or shapes.
Crop: Use this tool to crop out the part of a picture or shape you do not want to see. Just select the picture you want to crop, click on 
this tool, then move the handles on the picture to only show the part you want. Or, you can move the picture within its ‘window’. 
The picture will still be intact, but you will only be able to see a portion of it. 
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Place Toolbar
The Place toolbar is a selection of automatic tools for working with all objects in PrintMaster Gold. With these tools, you can easily 
select pictures partially hidden behind another, group together objects you want to move as one, or flip pictures horizontally and 
vertically.
To hide or display the Place toolbar, access the View menu, then Toolbars/Place Bar.

Forward One: Click this tool once to bring the active object up one level.
Backward One: Click this tool once to push the active object back one level.
Send to Front: Click this tool to bring the active object to the top of a stack of overlapping objects.
Send to Back: Click this tool to send the active object to the bottom of a stack of overlapping objects.
Group: Use this tool to group several objects together. First select all the pieces you want to group by clicking on them one by one 
while holding down the Shift key, then click on Group. The grouped objects will now act as one.
Ungroup: Click this tool to ungroup several objects you have previously grouped.
Mirror: This tool flips the active object horizontally.
Flip: This tool flips the active object vertically.
Center on Page: This tool centers the active object in the middle (half way between the top and bottom and left and right sides) of the 
project.

Status bar 
The Status toolbar is displayed at the bottom of the PrintMaster Gold window. Use this area to change your view of your project or 
to check the accuracy of your measurements.

To hide or display the Status toolbar, access the View menu, then Toolbars/Status Bar.

View Side: Click either the left arrow or the right arrow to see the different sides of your project. You can also click directly in the 
middle of the View Side window to see a pop-up menu of different views. Note: only available in cards, brochures, and newsletters.
View Size menu: Click the Plus or Minus magnifying glass to view your project closer or farther away. You can also click in the 
middle to view a pop-up menu of different viewing sizes.
Note: You can zoom in to your project in the Workspace by pressing the plus (“+”) key and zoom out by pressing the minus (“-”) 
key on the number pad of your keyboard. 
Zoom to Area: This option changes the cursor into a magnifying glass, allowing you to drag across just the area you want to view 

User's Guide Page  15 Die, 5. Jul 2016
Chapter 3: The World of PrintMaster Gold



close-up.
1. Select this option and position the magnifying glass to the left and above of the object you want to magnify.
2. Hold down the mouse button and drag the magnifying glass across and down the layout screen until the item of focus is enclosed 
in a box. Then release the mouse button.
Location: This window shows the cursor’s location on the project page. If a picture is selected, the Location window will show the 
graphic’s upper left handle location. The first number indicates the cursor or picture’s location on the top ruler, while the second 
number shows the cursor or picture’s location on the left ruler. Click on this window for more position options.
Select Dimensions: This window shows the dimensions of the currently selected text box or picture. Click on this window for more 
size options.
Rotation Angle: This window displays the angle of rotation of the object selected. The number will increase or decrease as you rotate 
the object. Click on this window to custom rotate the object.

Ready Made Gallery
PrintMaster Gold comes with hundreds of pre-made templates, including bright, serious, colorful, and wild Ready Mades for every 
occasion. Before starting a project, it’s always a good idea to check the Ready Made Gallery to see if there’s already one there that fits 
your needs. You can save a lot of time by making a few changes to an existing document instead of starting from scratch.

Project: Select this pop-up menu to select one of the many PrintMaster projects.
Category: Select this pop-up menu if you have a specific category of project you want to view. This menu will show you all the 
different categories--like Birthday, Holiday, or Graduation--that are available within that type. Many categories have subcategories 
so, if you want, you can view only those projects that fit your needs.
Tone:  Select this menu if you want to view only those projects with a certain tone, be it humorous, sentimental, or traditional.
Style: Many Ready Made projects have been created in different artistic styles--from realistic to abstract, from cartoons to paintings. 
Use this menu if you want to view only one particular artistic style.
Media: PrintMaster Gold Ready Made projects are created with all types of media: watercolors, pencil, charcoal, photos, and more. If 
you’d like to see only the projects created with one type of media, make your selection in this menu.
Keywords: You may find it easier to select the type of project you want by typing in a word in the keyword box, then clicking on Find 
Now. PrintMaster Gold will find all the projects that match your criteria. Note: use the star (“*”) wildcard to find all versions of the 
word you are searching for. For example, “Sport*” will find not only “Sport”, but “Sports” and “Sportsmen”.
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Art Gallery
The Art Gallery contains thousands of drawings, photos, borders, and paintings, many created specially for PrintMaster Gold. 
Browse through the Art Gallery to find the picture you are looking for, or just browse to get ideas.

Art Collection: Use this menu to select which collection of art to view. You can view all available art, just PrintMaster Gold art, your 
own art you’ve created, or art from the PrintMaster Gold Graphics CD Catalog. As you add or create art in the future, the new 
pictures will be stored in the Your Own  section. 
+ Note: You can view the hundreds of images in the Graphics CD Catalog and purchase them via modem, phone, fax or mail. They 
are not available for use in your projects until you receive an access code upon purchase.
Category: Use this menu to select the category of art you want--from animal to Western images. 
Tone:  Use this menu to select all the pictures in the Art Gallery by tone--be it humorous, sentimental or contemporary.
Style: The PrintMaster designers have collected and created art from all types and styles--from Realistic paintings to Cartoons. Use 
this menu if you would like to only see one style of art.
Media: Select this menu if you would like to see only one type of media, from watercolor to woodcut. 
Keywords: You may find it easier to select the type of art you want by typing in a keyword in the keyword box, then clicking on Find 
Now. PrintMaster Gold will then find and display all the art that matches your criteria.

Sentiment Gallery
The Sentiment Gallery contains hundreds of sayings, phrases, and messages for you to choose from. Each sentiment is in two parts: 
the phrase that will appear on the front of the project, and the phrase that will appear on the inside of the project. After you select 
the appropriate sentiment, each phrase will be automatically placed on your project.
+ Note: Sentiments only available in PrintMaster Gold Publishing Suite.

Like the Art and Ready Made Galleries, the Sentiment Gallery allows you to search by Category (from Anniversary to Wedding) and 
Tone  (Humorous, Sentimental, Traditional, Contemporary, and Spiritual). You can also type a word in the Keyword box and 
PrintMaster will find all sentiments that match your request.
+ Note: use the star (“*”) wildcard to find all versions of the word you are searching for. For example, “Birth*” will find not only 
“Birth”, but “Birthday” and “Birthdays”.
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With Help Designer
Would you like some help creating your project? The With Help Designer is ready to help you create your own beautiful, 
personalized project. Just click the With Help button and the With Help Designer will ask you a few simple questions about the type 
of project you want to make, its orientation, and the kind of art and text you would like.

You can always change your mind in the With Help windows. Just click Back, then make your changes. View the results of your 
choices in the sample windows. Once you are happy with your creation, click Finish and your project will be placed in the 
Workspace, where you can add additional text, make a few final changes, and print.

Brand New
If you know the kind of project you want to create or would just like to try several versions, Brand New may be the best place for 
you to start. After you click Brand New, you will be asked a few simple questions about the type and orientation of your project. 
Then you’ll be taken to the Workspace where you can create anything your heart desires.

Your Projects
Your Projects holds all the PrintMaster Gold projects you have created in the past. If you like, you can add new Keywords to each 
project you create so you can find them more easily in the future.

Internet
If you have an Internet connection and a World Wide Web browser, you can access our PrintMaster Gold Web site to get more 
information on new upgrades, get late-breaking PrintMaster Gold news, download additional graphics, or trade design tips with 
other PrintMaster Gold users. When you click the Internet button, PrintMaster Gold will search for your Internet browser and 
launch it. After the browser opens, follow the on-screen instructions to reach the PrintMaster Web site.
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        Tutorials
       Card Project Tutorial
To get your feet wet, let’s start with a card that already has art, sentiments, and size chosen for you—what we call a Ready Made. 
Remember, no Ready Made is set in stone. In PrintMaster Gold, you can make just about any change you want, from turning a 
Birthday Greeting into a Get Well card or a Get Well card to an invitation.

In this Card Project Tutorial, we will:
• Introduce the Hub Screen
• Introduce the Ready Made Gallery
• Select a Ready Made Birthday card
• Edit text
• Move a picture
• Resize a picture
• Rotate a picture
• Add a new picture from the Art Gallery
• Add a new sentiment from the Sentiment Gallery
• View, save, print, and fold the card

Selecting a Ready-Made Card Project
After you launch PrintMaster Gold, you'll land in what we call the Hub.

The Hub is where it all starts. If you know exactly what you want and want to design your project yourself, you might start with 
Brand New. If you are a little unsure and wanted guidance every step of the way, you might choose With Help. 

For now, let’s go with a Ready-Made. Here, we’ll take a look at some of the thousands of cards our vast team of artists have already 
created. Then, we’ll make a few changes to make it our own.
1. Click Ready-Made. 
The Ready-Made button takes you to the Ready-Made Gallery. Here’s where you choose your project type, category, tone, style, and 
media. If you have an idea of what you’re looking for (like “Father” or “Birthday”), you can type the word in the Keyword box and 
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click on Find Now. PrintMaster Gold will search for all the projects that match your request.
2. In the Project type menu, select PrintMaster/Card.
3. In the Category window, select Birthday.

Browsing the Cards
Several thumbnail selections will appear in the Gallery window to the right of the Gallery menu. To see more Card projects within 
the same category, scroll down the selection or click the View Size Window on the bottom of the Gallery window. 

+ Note: You can also search for a project by using the Keyword search. Type in any word into the Keywords box and PrintMaster will 
find all the projects that match your request. Use the star (“*”) wildcard to find all versions of the word you are searching for. For 
example, “Sport*” will find not only “Sport”, but “Sports” and “Sportsmen”.

Select the card you like by clicking on it once so it is highlighted, then click the Select button at the bottom left of the Gallery menu. 
Or, after selecting the card, press the RETURN key or double-click the preview.

Personalizing your card
After selecting the card you want to work on, you’ll be taken to the Workspace. The Workspace is like a drafting board, with all the 
text, drawing, and positioning tools you’ll need to personalize and adjust your Ready-Made.

Editing Text
Perhaps the card you picked has a fun headline, but you might want to write something even better. No problem. Let’s make some 
adjustments to the text.
1. To edit the headline, click once on the text. Notice the insertion point blinks where you clicked between the letters. Also, notice 
eight ‘handles’ have appeared around the text box. You can use these handles to reshape your text box. Notice also that in the text 
menu above the card, the text status bar is updated–it tells you the font, the size, and the style of your headline.
2. Highlight the text you want to change by holding down the mouse button and dragging across the letters. Type in the new text (for 
example, “Dear Friend: Don’t fight it. You’re ancient!”).
Tip: A large, full-page photo or other image on the front of your card, with a few select words (like “Thanks!” or “Surprise!” is 
strong and effective.

Adjusting pictures
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Perhaps you like the pictures on your Ready-Made card, but you’d like to move them around a bit. No problem.
1. Click on a picture on your card. Be sure to click directly on an opaque section of the picture, and not on the background behind it. 
Once you click on it, you will notice again that handles appear on the edges of the picture boundary. That’s how you know it’s 
‘active’.
Hint: the objects on your project are placed in layers. The first object is on the bottom, and each object is placed above it, one by one. 
To view each object by layer, repeatedly hit the Tab key. Once the object your are interested in becomes active, you can work on it 
(adjust its size or color, for example) without changing its order in the stack.
2. When the cursor is now over the opaque section of the ‘active’ picture, the cursor turns into a ‘hand cursor’. That means you can 
now move the picture by holding down the mouse button and dragging the picture wherever you want. Note: You can also move 
the active picture, pixel-by-pixel, by using the arrow keys.
3. To resize a picture, drag one of the handles located on the outside edge of the picture’s boundary box out to make it larger, or drag 
it in to make it smaller.
4. To rotate the picture, make sure the picture is active (the handles around it are showing). You’ll notice that when your cursor 
passes over one handle on its side, the cursor turns into a rotating arrow. This is the ‘rotate handle’. Now drag the rotate handle 
around the picture to the angle you desire.
 Note: The rotation feature is only available on some graphics.

+ Hint: The objects on your project are placed in layers. The first object is on the bottom, and each object is then placed above it, one 
by one. To view each object by layer, repeatedly hit the Tab key. Once the object your are interested in becomes active, you can work 
on it (adjust its size or color, for example) without changing its order in the stack.

Adding pictures
After making adjustments to your pictures, you may now want to add another picture to make it your own special creation.
1. To add a picture to your card, click the Add Picture button on the left menu bar. The Art Gallery will replace the Workspace:
2. Choose a Category, Tone, Style, or Media for your new picture. Or, if you want to search for a picture using Keywords, type a few 
words into the Keywords window and click OK. 
+ Note: use the star (“*”) wildcard to find all versions of the word you are searching for. For example, “bird*” would find not only 
“Bird”, but “Birds” and “Bird Bath”.
3. Select the picture you want by clicking on the preview twice in the Gallery Viewing Area. Or, click on the preview once so it is 
highlighted, then click Select on the Gallery menu.
4.  The Art Gallery will disappear and your picture will appear in the middle of your card project. You can now move it or adjust it 
using the techniques described above.
+ Note: PrintMaster Gold can import many different types of graphic formats, including CGM, TIFF, PSD, JPG, PCX, GIF, BMP, and 
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Kodak Photo CD.

Adding sentiments
Perhaps you’ve decided the quote on your card is OK, but not just right. It’s easy to change it with our Sentiments Gallery. There you 
can browse the thousands of sayings, quotes, and jokes created by our witty scribes. Available only in PrintMaster Gold Publishing 
Suite.
1. To add a new sentiment to your card, first click on the existing text on your card and delete it. Then click the Sentiment Gallery 
button on the Add Toolbar in the Workspace. The Sentiment Gallery will appear above the Workspace.
2. Choose a Category, subcategory, or Tone you are looking for, or search for a specific sentiment using Keywords.
3. Select the Sentiment you want by clicking Select.
4.  You will be returned to the Workspace and your Sentiment will appear in the middle of your card. Note that some quotes 
include both a ‘front’ quote that only appears on the front of cards, and an ‘inside’ quote that will appear on the inside of the card. 
You can move the text or adjust it using the techniques described above.

Hint: If the cover of your card is strong enough, you don’t need to place much (if any) text on it. By placing the sentiment only inside 
the card, you increase its impact. Sometimes, less really is more. Pete Russitano - PrintMaster designer

Viewing Your Work
Selecting a Panel: 
Cards are made up of four separate panels comprising the front, back, and inside surfaces of the card. Each panel can have its own 
background, text, and picture elements. You can select the Card panel you want to view by clicking the View Face menu at the 
bottom of the Workspace.

Zooming in and out
You can look closer at your card by clicking the View Size menu. Click and hold down on the View Size menu at the bottom of the 
Workspace and go to 100%, 200% or any other percentage you want.

+ Note: You can also zoom in to your project in the Workspace by pressing the plus (“+”) key and zoom out by pressing the minus 
(“-”) key on the number pad of your keyboard.

User's Guide Page  22 Die, 5. Jul 2016
Chapter 4: Card & Photo Project Tutorials



Print Preview
You can view your project before printing by clicking the Print Preview button on the Global Toolbar. In the Print Preview menu, 
you can zoom in, zoom out, and print your project.

Save Card
Now, before we print, it’s time to save your project.
1. Click the Save  button located on the Global menu at the top of your screen, or hold down the File menu, and go to Save . 
PrintMaster Gold will prompt you for a unique file name. 
2. Type a name into the box provided. You may also attach a short description to your card project by typing it into the Description 
box.
3. To change the default drive and/or folder that your project will be saved to, click Change... and select the new destination.
4. Click OK or press RETURN to save your card project.

Save Picture Files in Project: This feature is particularly useful when using pictures that are selected from a floppy disk or CD, or 
when you expect to place your card on a disk and pass it to a friend. When Save Picture Files in Project is selected, PrintMaster Gold 
will not require you to insert the floppy disk or CD containing the picture(s) used the next time you or your friend opens your 
project.

Print Card
You’re almost done! As the last, and most rewarding step, let’s print your project. 
1. First, make sure your printer is turned on and you have selected the correct paper size in Print Setup (under the File menu).
2. Click the Print button to display the Print dialog box. From this dialog you can also choose the number of printed copies, the print 
quality, and other features. See the chapter Printing a Project for more information.
3. Click Print to begin printing your project.

How to fold a Card
Card projects come in all shapes and sizes: wide, tall, big, and small. Ultimately, the size of your card will depend on what sizes are 
supported by your printer, and the paper size you choose. Here are three ways you can fold your card (determined by the type of card 
you’ve chosen).
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Quarter Fold
A quarter-fold card is made from regular 8 1/2” x 11” paper, folded into fourths. It prints on one side of the paper and may be either 
horizontal or vertical.
1. For either a vertical or horizontal card, fold the paper in half across the middle, with the printing on the outside.
2. Fold the paper in half again.
Single Fold
A single-fold card is folded once, in half. It may be either horizontal or vertical. For a nicer looking card, print the outside on 
heavier paper and the inside on lighter paper. Then fold them together, placing a bit of glue on the front inside face of the card to 
hold the lighter paper in place.
Z Fold
A Z-fold card prints on one side of the paper and folds into a brochure. It is always vertical.
1. Fold the front third of the card with the printing on the outside.
2. Fold the inside of the card by aligning the edge of the paper with the fold made in Step 3. You can now use a bit of glue to seal the 
front to the middle face.

Return to the Hub
Now that you’ve created and printed your first card, we can return to the Hub, where you can chose another Ready-Made card or try 
any of the hundreds of other projects waiting for you.
1. Click the Close button to exit the Workspace and return to the Hub. If you have not already saved your Card, you will be 
prompted to do so at this point.

Design Tip from the Pros

“The receiver of a card usually expects to see the front text near the top of the card. They’ll read it quickly, then flip to the ‘zinger’ 
quote inside. So, it’s not a good idea to scatter text all over the front of a greeting card.... It’s also a good idea to have the text on the 
front of the card line up visually with the text on the inside the card. The eye tends to stay at the same place when the card is 
opened.”
 Lori Saulsen, greeting card designer

PrintMaster Gold User Tip
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“I make my Mom a birthday card every year. Every year it’s just a little different, but every one of them includes one thing: a rose. 
Every year, a rose turns up somewhere--behind the headline, behind a tea kettle graphic, or maybe even on the back--but it’s there. 
It’s become a bit of a game for Mom to find it. But I know she loves roses, so I wouldn’t ever send her a card without at least one.
 Martin Mulon, Oklahoma City, OK

                             Photo Project Tutorial
Ever wonder what you would look like as a cowboy or the President of the United States? Photo Projects are a fun way to create 
pictures of you or your friends in fun scenarios, scenes, and poses. All you need is a Photo Project and a picture of your friend. You’ll 
be surprised at the effect!

+ Note: Photo projects are available available only in PrintMaster Gold Publishing Suite.

In this Photo Project tutorial, we will:
• Select a Ready Made Photo Project
• Import your picture file from disk
• Acquire an image using PrintMaster’s TWAIN support
• Place your image behind the Fun Photo template
• Resize an image
• Crop an image
• Save your Photo Project
• Save picture files in your project
• Print your Photo Project

Select a Ready Made Photo Project
1. From the Hub screen, click Ready Made. If you are in the Workspace, click the Ready Made button on the Global button bar. You 
will be taken to the Ready Made Gallery.
2. In the Ready Made Gallery, select PrintMaster/Photo Projects under Project Type. PrintMaster Gold offers several different 
categories of Photo projects from which to choose. If you would like to narrow your search, choose a Category, Tone, and Style.
3. Find the photo project you like, click on it once, then click Select (or, double-click on the preview). Your selection will then be 
placed in the Workspace.
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Import your picture file from disk
The Photo project is comprised of a Fun Photo, text, and graphic elements. The photo has been altered to allow you to place a picture 
of you or your friend’s face behind it, creating the illusion that the face is attached to the body in the picture.
To add a picture you have on disk to your photo project:
1. Open the Art Gallery by clicking the Add a Picture button on the Add menu.
2. Once you are in the Art Gallery, click Open from Disk under the File menu. You will then see a dialogue box. If your file is not 
displayed in the window, scroll down to the appropriate path.
3. Select the file you want to import. Click OK. Your picture will be placed in the middle of your project in the Workspace.
Tip: PrintMaster Gold can import many different types of graphic formats, including CGM, TIFF, PSD, JPG, PCX, GIF, BMP, and 
Kodak Photo CD.

Acquire an image for your project
PrintMaster Gold includes all the tools you’ll need to acquire photos and graphics for your projects. PrintMaster Gold includes 
TWAIN support so you can easily acquire images from a flatbed scanner, digital cameras, and more.
+ Note: Before acquiring an image in PrintMaster Gold, you will first need to install the scanning software and drivers that came 
with your scanner or digital camera.

To Acquire an image with your scanner or digital camera:
1. Under the File menu, click Acquire. The scanning software that came with your camera or scanner will be launched.
2. Scan your image according to the directions that came with your scanner or digital camera. The TWAIN support within 
PrintMaster Gold will allow you to easily transport that image into PrintMaster Gold.
Tip: If your scanned photos look blurry when placed in the Photo project, try scanning them at a higher dpi (dots per inch) setting, 
perhaps at 400 to 600 dpi.
3. Once the image is scanned, you will see the Save Acquired Picture window. Type in a name for your new scanned image, and if 
you like, a description of the image. If you would like the scanned image to appear in the Art Gallery in the future, click the box at 
the bottom of the window.
4. Click OK. Your scanned image will be placed in the middle of your project in the Workspace.
You will then be returned to PrintMaster Gold’s Workspace, where your adjusted image will be placed on your project.

Increasing PrintMaster Gold’s default memory size: If you are going to work with PhotoCD’s or scanned images, it’s a good idea to set 
the Size Resource to at least 24 Megs (or 32, if possible) by selecting the PrintMaster Gold Icon in the finder, select Get Info under the 
File menu  and increase the Preferred Size to as large a number as you have memory space.
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Place your image behind the Photo Effect template
Objects on your project are layered in the order in which they are placed on the project. The first object placed on your project will be 
on the bottom, and every object placed after it will be stacked above it.

To get your image to show through the Fun Photo opening, you’ll need to first place it behind the Fun Photo template.
1. Click once on your image so it is the ‘active’ object in your project (the handles are showing around it). 
2. Move your image so the face is approximately over the opening in the Fun Photo.
3. While your image is still active, click the Backward One button on the Place menu. Your image should appear behind the Fun 
Photo. If it does not, click the Backward One button again until your image is one level behind the Fun Photo template.
Tip: Press the Tab key several times to view the different layers of objects on your project.
4. Click inside the face opening of the Fun Photo. Now you can move your image to align it with the opening on the Fun Photo, 
without bringing it forward.

Resize an image
You may find the face on your image is too big or too small to fit properly in the Fun Photo opening. The following steps will help 
you resize your image so your Photo Project will appear more realistic.
1. Make sure your image is ‘active’ (handles showing around its edges). If it is not, click inside the opening of the Fun Photo, directly 
on your image, to make it active. If you are having trouble selecting your image, repeatedly hit the Tab key to cycle through the 
different levels of objects in your project until your image is active.
2. Once your image is active, place the cursor on the handle (the small square box) on the bottom right corner of the image. You can 
now drag the mouse diagonally out and down to make the image larger. To make sure the image keeps its exact proportions, hold 
down the Control (Ctrl) key while dragging.

Crop an image
Your scanned image may be too large or include things you’d like to crop out. PrintMaster Gold has a cropping tool that allows you 
to see only the portion of the photo you want to see, without removing or disturbing any part of the image.
To crop your image:
1. Make sure the image you want to crop is active (handles are showing).
2. Click the Crop tool on the Modify toolbar.
3. Place the cursor over any handle of the image. The cursor will turn into a cropping tool. You can now drag the handle to create a 
new window through which you will view your image. 
+ Note: You are not altering the image, you are just reducing or enlarging the ‘window’ through which you can see that image.
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4. With your image still active and the cropping tool button selected, place the cursor over the center of the image. The cursor will 
turn into a ‘move’ hand. By clicking and dragging your image, you can move the image within the cropped window to see only the 
portion of the image you want.
Tip: When you click on an object, make sure you click on an opaque part of each object. If you click on a clear or transparent part of 
an image, you will most likely select the object underneath it.

Save your Photo Project
Let’s save your Photo Project with a unique name and attributes so you can easily find it in the future.
1. Click the Save  button on the Global toolbar. To save an existing Photo Effect project under a new name and description, select 
Save As... from the File menu. PrintMaster Gold will then prompt you to type in a new file name and description.
2. Type the new File Name into the box provided.
3. You may also attach a short description to your Photo Effect project by typing it into the Description box. Or, you can add new 
words to the keyword list so you can more easily search for it in the Your Own Gallery.
4. To change the default drive and/or folder that your project will be saved to click Change... and select the new destination.
5. Click OK or press RETURN to save your Photo Effect project.

Bright Idea: If you would like to print your Photo Project on to an iron-on transfer, first select all the items on your project (Ctrl-A), 
Group them (click Group button), then click the Mirror button so all of the objects are flipped. Now, when you iron the images on to 
a T-shirt, they will appear correctly.

Design Tips from the Pros

“I’ve found the best way to make a Photo Project is to first look for a snapshot of one of my friends that is bright and clear. Then I 
scan the photo at as high a resolution as I can--usually around 600 to 700 dpi works best--so I can make the image larger in 
PrintMaster Gold without distorting it or making it look jagged.” Ginna Allison - PrintMaster designer

PrintMaster Gold User Tip

“Last Valentines Day, I made my husband a photo project he really loved. I got my picture taken at one of those booths at the airport, 
scanned it, and put the picture behind the ‘Beach Baby’ template. Then I printed it out, signed it, and framed it. My husband LOVES 
it. Now I’m doing one for him with his picture behind the ‘Gunslinger’ photo template.” Laura Pall - Atherton, CA
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           Newsletter Tutorial
PrintMaster’s Newsletter Ready Mades can help you create sharp, colorful newsletters fast. Our Ready Made templates include all 
the pieces you need: headlines, columns, connected text boxes, and graphics. Plus, PrintMaster’s Newsletter project can be used to 
create bulletins, newspapers, reports, and other multi-page documents.
+ Note: Newsletter projects are available only in PrintMaster Gold Publishing Suite.

This Newsletter tutorial will show you how to:
• Open a Ready Made Newsletter template
• Create a new Newsletter
• Connect Text Boxes
• Disconnect Text Boxes
• Insert Additional Pages in your Newsletter
• Save a Newsletter project
• Print a Newsletter project.

Open a Ready Made Newsletter template
The PrintMaster Gold Ready Made Gallery provides many different categories of Newsletters to choose from.
1. From the Hub screen, click Ready Made. If you are in the Workspace, click the button on the Global button bar. You will be taken 
to the Ready Made Gallery. To narrow your search for an appropriate newsletter design, choose a Category, Tone, or Style.
A larger preview of a newsletter can be viewed by clicking the View Size menu at the bottom of the Ready Made Gallery window 
and selecting the Large option. You can then view the pages of the newsletter template by clicking on the Page View pop-up menu. 
To return to the standard preview open the View Size menu again and select View Medium.
2. Once you find the newsletter design you want in the Ready Made Gallery, click on it, then click Select (or double-click your 
selection). The newsletter you selected will then be placed in the Workspace, ready for you to work on.

Tip: Prioritize information in newsletters and brochures. Establish areas with current news ‘bites’ to highlight events or set off 
helpful tips. Breaking up longer, in-depth stories with shorter, fast-paced ones establishes a good information flow.   Pete Russitano - 
PrintMaster Designer

To create a new Newsletter
1. Click the Brand New button in the Hub.
2. When creating a new newsletter, you will be prompted to select a page layout for your new project. Use your mouse to select the 
Newsletter Size.
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 • The Size option Tall (or Portrait) prints text across the short width of the paper.
 • The Size option Wide (or Landscape) prints text across the long width of the paper.
3. Once you have selected the newsletter size, click Finish. Your blank newsletter will be placed in the Workspace, ready for you to 
enter your own text and graphics.

Connecting Text Boxes
When typing long passages into a text box, the text may run longer than fits in the box you created. The extra text isn’t lost, you just 
can’t see it within the frame of the text box. When your text overflows the text box, you can connect to another empty text box 
anywhere in your newsletter, so the text will flow from one box to the other.
1. Click the Link icon at the bottom of your first text box. You will notice if you then move the cursor over the text, it will become a 
Text Pour  icon. You can now pour the overflow text into any other empty text box.
2. Click into an empty text box where you want the overflow text to go.
+ Note: You cannot connect two text boxes with the Text Pour icon if the destination text box already has text in it.

Viewing All Connected Text Boxes: You can view all connected text boxes by clicking on the Previous or Next Text Box arrows at the 
top and bottom of each active text box. Click the right arrow (Next Text Box) to view the text box that contains the overflow from 
that box. Click the left arrow (Previous Text Box) to view the text that comes before the text in that box.

Tip: Small, neatly placed icons or pictograms, when used with a primary design element (like color boxes) can help illustrate 
difficult concepts, such as travel, time, technology, and emotions. Pete Russitano - PrintMaster designer

Disconnecting Text Boxes
To disconnect two connected text boxes:
1. Click on the first text box you would like to disconnect. The text box will display a Next Text Box button (right arrow), showing 
that it is connected to another text box.
2. Click the Link button. The cursor will again turn into the Text Pour icon.
3. You can then either:
• Click inside the active text box, disconnecting that text box from all following boxes. The text will now stay within that text box, or 
• Click into another empty text box, connecting the text to the new text box.
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Inserting Additional Pages
One of the unique features of a Newsletter project is the ability to work with multiple pages. To insert additional pages to your 
Newsletter, proceed as follows:
1. Pull down the Add menu with your mouse and select Pages.
2. In the dialog displayed, type in the number of pages to add.
Where—Use this option to determine the placement of additional pages. Choose either:
 • Before Current Page
 • After Current Page
Contents—Use this option what type of pages to add to your Newsletter. Choose either:
• Add Blank Pages
• Add Copies of Page—Use this option to duplicate existing pages by typing in the page number the section to duplicate.
3. Press RETURN or click OK to add your new pages.
+ Note: To add pages quickly, click the right arrow of the View Page menu (at the bottom of the screen) while viewing the last page 
of your newsletter. This will bring up the Add Page dialog box, where you can add a page or pages to your project.

Save Newsletter
This command will enable you to save your Newsletter project with a unique name and description that you provide.
1. Click the Save  button located on the Global toolbar. To save an existing Newsletter project under a new name and description, 
select Save As... from the File menu. PrintMaster Gold will then prompt you to type in a new file name and description.
2. If you are saving a new Newsletter project, PrintMaster Gold will prompt you for a unique file name. Type in the new File Name 
into the box provided.
3. You may also attach a short description to your Newsletter project by typing it into the Description box. You may also enter 
keywords so you can search for your newsletter in the Project Gallery.
4. To change the default drive and/or folder that your project will be saved to click Change... and select the new destination.
5. Click OK or press RETURN to save your Newsletter project.

Print Newsletter
This option brings up the Print dialog enabling you to print your Newsletter project. From this dialog you can also choose the 
number of printed copies, the print quality, and other features.
1. Click the Print Newsletter button to display the Print dialog box.
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2. Click Print to begin printing your project.
Print Range — Use this option to select what pages of your multi-page document to print.

Double-Sided Printing
PrintMaster Gold includes an easy-to-use Double-Sided Wizard to help you determine the best way to print your double-sided print 
projects.

The Double-Sided Print Wizard takes you step-by-step through a sample printing project, and according to your responses, 
configures PrintMaster to print double-sided projects automatically in the future.
1. Once your double-sided project is completed, select the Print button on the Global toolbar or type Command+P. 
2. Make sure Double-sided is checked on the Print dialog box. 
3. Click Print. The first time you print a double-sided project, you will see the Double-Sided Wizard. If you have not yet set your 
double-sided print configuration and the Wizard does not appear, select Double-Sided Print Setup... under the File menu.
2. The Double-Sided Print Wizard will first ask you to print a 2-page test project. After the two pages are printed, follow the 
directions on the Wizard screen. You will be asked to match the orientation of the printed pages to icons on the Wizard screen, place 
the pages back in the printer, print again, then select the configuration that matches the final printout order.
3. Once you have answered the questions on the Wizard screen, click Finish. PrintMaster Gold will now be configured for 
subsequent double-sided printing. You can now print multiple-page, double-sided projects such as newsletters, cards, and envelopes.

 Address Book and Label Tutorial
PrintMaster Gold’s Address book is an easy way to keep track of names, addresses, and birth dates, and merge information into all 
types of projects. The Address Book, used with Fill-in Fields, can print dozens of personalized holiday cards for all your relatives, 
invitations for your friends, labels for your customers, or certificates for your students.

This Address Book and Label Tutorial will show you how to:
• Create a new Address Book
• Create a new Label
• Open a Ready Made Label
• Add Fill-in Fields to your Label project
• Apply values to the Fill-in Fields
• Save your Label project
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• Print your Label project

Creating a new Address Book
The Address Book is a good way to electronically keep track of names, addresses, birth days, and other information. The best thing 
about PrintMaster Gold’s Address Book is that it’s an easy and powerful way to merge the names and addresses of your friends, 
family, or other acquaintances into any PrintMaster Gold printing project!

The following instructions describe how to create a new Address Book.
1. From anywhere in PrintMaster Gold, pull down the Tools menu with your mouse and click Address Book.
If you have not already created an Address Book, PrintMaster Gold will start you off with a blank address book called: Address. You 
can edit this address book or click New under the Address Book File menu and create your own using a different name.
2. Use the displayed fields to begin entering the basic information for each person you’re adding to your Address Book. You can fill 
in any fields you want, but it is best to include at least the First Name and Last Name. The available fields are:
• First Name, Last Name
• Relationship—Use the pull down menu to select one of the predefined values for this field or type in your own. New values 
typed in will be added to this menu so that you may select them again for use with other Address Book entries.
 The Relationship field can also be used to sort records in your Address Book.
• Title, Company, Address1, Address2, City, State, Zip
• Country—Use the pull down menu to select one of the predefined values for this field or type in your own. New values typed in 
will be added to this menu so that you may select them again for use with other Address Book entries.
• Phone, Fax
• Email—Use this field to type in an Internet email address.
• Birthday, Anniversary
• Comments—Use this field to type in generic data or personal comments. 
• Picture—Use this field to add pictures of friends, family members, or employees to your Address Book.
• User Defined Info—Use this field to enter important data not covered by the standard fields listed above.
• User Defined Date—Use this field to enter dates not covered by the standard fields listed above.
3. Click the New button to begin working on a new record for your Address Book. Use Tab and Shift+Tab to navigate to the next 
field or backup to a prior field.
4. Click the Save  button to add a completed record or save changes to an existing record. To remove an entry click the Delete button. 
To reverse changes made to a record click the Undo button.

Creating a new label
User's Guide Page  34 Die, 5. Jul 2016

Chapter 5: Newsletter, Address Book,  & Calendar Tutorials



Now that you have some information in your Address Book, let’s create a label and have PrintMaster Gold automatically insert 
your Address Book information into each label.

PrintMaster Gold makes it easy to create dozens of different types of labels for envelopes, floppy disks, video cassettes, name tags, 
and many more.
To create a new label:
1. From the Hub screen, click Brand New. Then, in the New Project dialog box, choose Label.
2. You will be prompted to choose a Label Type.
 • Select Laser Labels if you will be printing your labels on a laserjet, inkjet, or bubblejet printer.
 • Select Dot Matrix Labels if you will be printing your labels on a dot matrix printer.
3. From the provided list, pick the specific type of labels to be used. Click OK to begin editing your Brand New label in the 
Workspace.

Open an existing Label
1. From the Hub screen, click Ready Made, then, under Project Type, choose PrintMaster/Label.
2. Browse through the Ready Made labels to find one you like. To narrow your search, select a Category or Style. Remember, you can 
make as many adjustments as you like to the Ready Made label once you enter the Workspace.
3. Once you have found a Ready Made label you like, click once on the label preview, then click Select (or, double-click the label 
preview). You will then be taken to the Workspace where you can work on your Ready Made label.

+ Note: The Ready Made label you chose in the Ready Made Gallery may not represent the label type you desire. To change the label 
type, click Edit in the menu bar, and click Choose Label Type. Then choose the label type you desire from the list presented. You may 
have to make adjustments to text size and graphic placement if the new label size is considerably different from the original.

Adding Fill-in Fields to your label project
Fill-in fields are placeholders that can be “filled-in” with personal information from your Address Book or with any information 
you type-in. 

To add a Fill-in field to your Label project:
1. Begin by adding a text box to your label project. If you are working with a Ready Made project, delete the sample text in the text 
box, but leave the empty box.
2. Make sure the empty text box is active (the handles are showing around it), and the insertion point (the blinking cursor) is placed 
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inside the text box.
3. Under the Add menu, select Field…. A list of available fill-in fields will be displayed. Use the scroll bar to move up or down the 
list of fields.
4. Pick a Fill-in field by clicking on its name.
5. Click the Insert button to add the selected field to your project page.
Or, to more easily insert standard information:
• Click the Receiver Address button to automatically insert Receiver First Name, Last Name, Title, Company, Address1, Address2, 
City, State, and Zip fields. This is often the best selection when you are sending out lots of mailers, envelopes, or invitations with a 
different name and address on each item.
• Click the Sender Address button to automatically insert the Sender First Name, Last Name, Title, Company, Address1, Address2, 
City, State, and Zip fields. This will create a series of labels with your name and address on each. This is best when you want to 
create many identical return address labels, cassette labels, books plates, or business cards.
6. To insert additional fields, repeat steps 4 and 5.

+ Note: Fill-in Fields do not have to be inserted into an empty text box. They can also be added to text boxes that already contain 
existing text. Fill-in fields are inserted at the text cursor position.

Applying Values to Fill-in Fields
Once you have placed fill-in fields onto your project page you will need to assign values to each of the inserted fields.
1. To begin, select Fill-in Field in the Edit menu.
A list of the field names used in your project will appear on the left side of the dialog box. To the right a space will be provided for 
typing in values for each of the fill-in fields.
You may enter your own values for each field, or you can select values from the Address Book so your Address Book information 
will be merged automatically.
2. To edit a field, simply click the field with your mouse and begin typing in the desired data.
 Use Tab and Shift+Tab to move to the next field or to backup to a prior field.
3. To automatically merge information from the Receivers List of your Address Book, click the Receivers... button.
4. Pick the receiver name(s) you wish to use by clicking on them with your mouse. Once you have chosen the desired name(s), click 
OK.
 Or, click All to have all the names in your Address Book merged into your project.
+ Note: When selecting multiple receiver names, only one of the chosen names will be displayed on the project page (generally the 
first one selected). You will also only see one name listed in Print Preview. However, upon printing your project each printed page 
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will contain a different receiver name.
5. Click OK to return to your project page.
Note that the fill-in fields seen earlier have been replaced by the first name in the receiver list you selected. At this point you can 
now begin editing your text by changing items like font, color, size etc.

Print Label
This option brings up the Print dialog enabling you to print your Label project. From this dialog you can also choose the number of 
printed copies, the print quality, and other features.
1. Click the Print button on the Global toolbar or hit Command+P on your keyboard to display the Print dialog box.
The following buttons are available on the Print dialog box:
Fill-in Fields 
This button allows you to make changes to the number of names that will be printed. To the right of the Fill-in Fields button is an 
indication of how many Fill-in fields PrintMaster Gold has retrieved from your Address book. To change that number, click the 
Fill-in Fields... button and re-select names from your Address Book.
Number of Labels
This button allows you to choose how many of each name merged from your Address Book to print out. For example, if you are 
merging three names from your Address Book, you can choose to print each name twice by typing “2” in the Number of Labels box.
Starting Label
Use this item to specify the starting label on any printout. This feature is useful when printing to a page containing only a partial 
number of labels. On printouts consisting of multiple pages, this feature will only apply to the first page. Any additional pages will 
start printing on the first label.
2. Click Print to begin printing your project.

Design Tips from the Pros

Fonts for mailing labels should be clear and bold and be at least 10 point or larger, even for small return address labels. I’ve found it’s 
very professional looking to add a small graphic in the upper left corner of my address labels that also matches my letter head. It 
gives my packages a professional, coherent look. I do not, however, put any color behind the text. Color often makes small text hard 
to read. Macy Alpin - PrintMaster Gold designer
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                      Calendar Tutorial
With PrintMaster Gold you can design a Calendar to fit in your wallet or fill a bulletin board. Monthly, weekly, and generic calendar 
styles are available and any day can be enhanced with both text and pictures.

The following instructions describe how to: 
• Create a new Calendar project
• Open an existing Calendar project 
• Add text to a date
• Add pictures to a date
• Copy date information
• Review the Calendar menu options
• Save a Calendar project
• Print a Calendar project

Beginning a Calendar
1. In the Hub screen, click Brand New, select a Calendar project, and then click Next.
2. When creating a new Calendar, you will be prompted to select a page layout for your new project. First, use your mouse to select 
the Calendar Size.
• The Size option Tall (or Portrait) prints text across the short width of the paper.
• The Size option Wide (or Landscape) prints text across the long width of the paper.
3. Next, choose the desired type. PrintMaster Gold supports three Calendar Types.
• Monthly Calendars show a full month of dates.
• Weekly Calendars show a single week of dates.
• Generic Calendars are weekly Calendars without any specific date numbers.
4. Select the Calendar date (Month and Year. Also choose the Week for Weekly Calendars). Click the Now button to select today’s 
date. PrintMaster Gold will automatically label each day of Monthly and Weekly Calendars with the proper numbers based on the 
selected date.
5. Click Finish or press RETURN to begin editing your Calendar project.

To open a Ready Made Calendar
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1. From the Hub screen, click Ready Made. 
2. In the Ready Made Gallery, choose PrintMaster/Calendar. Under Category, you can choose either Monthly  calendars or Weekly  
calendars. If you would like to narrow your search, choose the Tone  or Style of the calendar you are looking for.
2. Highlight a Calendar project by clicking on its preview. To see other Calendar projects within the same category, scroll down the 
Ready Made Gallery preview screen.
3. Once you have found a calendar you are interested in, click the preview once, then click Select. Or, double-click the preview. You 
will then be taken to the Workspace.

Adding Text to a Date
Text can be added to a particular date by simply double-clicking on the date box with your mouse. 
+ Note: You may want to zoom in on the date you wish to add text to.

Adding Pictures to a Date
You can attach any picture to a date box. 
1. Click the mouse button over any date of your Calendar project. 
2. Under the Calendar menu, select Choose Date Picture... You will be taken to the Art Gallery, where you can choose your picture. 
+ Note: Only a single picture is allowed per date and the picture is always sized to fit the box.

Tip: Repeating elements on a page can create an exciting atmosphere. Change the size, color, tint, placement, and layer position of 
each repeated element to keep it interesting. This works great with snowflakes, balloons, flowers, Holiday ornaments, and even text. 
Pete Russitano - PrintMaster designer

Change Picture Color
To change the color shading of a picture attached to a date box, click Picture Color or Picture Attributes under the Calendar menu.

Copy Date Information
To copy the contents of one date box to another, click on the date box you want to copy and while holding down the mouse button, 
drag the date box to the new destination. When you release the mouse button, the text and pictures will be copied.

"Add dimension to your projects by using solid colors, patterns and screened back art in the background, instead of white. Also, a 
solid color in the background with a pattern at 60% of that color on top of it gives a watermark effect.” - Melissa Mahoney 
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PrintMaster Gold designer

Changing Calendar Information
Additional features for editing your calendars are available on the Calendar menu located at the top of the project screen.
Month and Year...
Use this option to change the Month and Year of your Calendar project. For Weekly Calendar projects you can use this option to 
change the week. PrintMaster Gold will automatically number the days for the date you choose.
Calendar Style...
Use these options to customize the look of your Calendar project. Click the Default button to reset all items to their original values.
Weekday Names
Use this option to edit the style of weekday names. Three variations of weekday names are offered:
• Text Only displays only the weekday names.
• Boxed Text displays the weekday names in boxes.
• Reversed Text displays the weekday names on a black background.
Weekday Spelling
Use this option to specify the spelling of the weekday names. Three variations are supported:
• Initials displays the weekday names as S, M, T, W, T, F, S.
• Abbreviations displays the names as Sun, Mon, Tue, Wed, Thu, Fri, Sat.
• Full Names displays the weekday names as Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday.
Lines
This option controls what lines are drawn around the Calendar date boxes. Lines does not effect any box drawn around weekday 
names.
• None displays no Calendar lines.
• Horizontal displays only horizontal lines.
• All Lines displays all Calendar lines.
Line Color
Click this button to choose the color for the lines drawn around the Calendar date boxes, the box drawn around the weekday names, 
and a color shadow.
Shadow
This option is used to add a shadow effect to your Calendar.
• No Shadow turns off any shadow effect.
• Black adds a black shadow to the Calendar.
• Gray adds a gray shadow to your Calendar.
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• Light Gray adds a light gray shadow to your Calendar.
• 100%, 50%, 25% Color adds a shadow of the chosen Line Color (see above) to your Calendar. The color is rendered at the selected 
percentage.
Outline
Select this option to add an outline around the entire calendar.
Edit Calendar Title Text
Use this option to edit the contents and style of the Calendar title. You can also edit the title by clicking on the project layout area 
with your mouse.
Date Number Font...
This option enables you to change the font style of the date numbers on your calendar.
Weekday Name Font...
Use this option to change the font style of the weekday names (Mon., Tues. Wed., etc.).
Edit Date Text
This option enables you to edit the text inside of a date box.
Choose Date Picture...
This option enables you to attach a picture to a date box. Only a single picture is allowed per date and the picture is always sized to fit 
the box.
Date Picture Color...
This features enables you to change the color shading of a picture attached to a date box.
Date Picture Attributes...
This option enables you to adjust attributes (color, render method, etc.) of the selected picture. (See the chapter entitled Working 
with Pictures later on in this guide for more detail.)
Clear Date
Use this option to remove text and picture elements only from the currently selected date. Other dates will remain unchanged.

Design Tips from the Pros

"Soft, muted colors are an important way to achieve subtle feelings in a design. They can soothe, warm, soften, add elegance and 
emotion, and are a welcome departure from the bright, jarring images of the day." Pete Russitano - PrintMaster designer

PrintMaster Gold User Tip:
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"I once used the calendar project for my girlfriend’s birthday, and it worked out great. Every day for two weeks, I printed out the 
same calendar with a new greeting at the bottom and another day crossed off. Then, every day I sent it to her. On the last day, I 
brought the last calendar to her office with roses. I think she liked the anticipation of the event as much as its arrival." Bob Alewon - 
PrintMaster Gold user
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More Projects & Tips
Matching Sets
With Matching Sets, you can create a look for your business, organization, or event effortlessly. Matching Sets include letterhead, 
business cards, brochures, newsletters, and envelopes so you can put your best look forward quickly.

Design and edit your Matching Sets as you would a normal PrintMaster card, letterhead, or brochure project. For more information 
on using the Ready Made Gallery, Art Gallery, and Workspace, see the Card and Newsletter Project Tutorials above.

+ Note: the text and pictures in each Matching Set project are not linked to each other. So, if you make changes in one Matching Set 
project (an envelope, for example), those changes will not be reflected in the others (a matching letterhead, for example). 

Matching Sets are only available in PrintMaster Gold Publishing Suite.

Design Tips from the Pros
To emboss a graphic shape such as a star or pencil into your letterhead, simply print out the shape of your choice and tape it to a 
heavier stock of paper. Using a sharp knife or scissors, cut the shape out of the heavier paper. Take the newly created stencil and 
secure it in the area you want to emboss on your letterhead. Then turn the paper over and use a blunt object (like a popsickle stick or 
spoon) to burnish a well-defined image. Karla Ebrahimi - PrintMaster designer

Brochures
The Brochure project can be used to create flyers, pamphlets, mailers, and other types of advertisement or informative literature. 
Just choose a two-fold, three-fold, or four-fold model, enter your information, and you’re on your way.

Design and edit your Brochure project as you would a Newsletter project. For more information on using the Ready Made Gallery, 
Art Gallery, and Workspace, see the Card and Newsletter Project Tutorials above.

When creating a new Brochure, you will be prompted to select a page layout for your new project. Use your mouse to select the 
Brochure Size.
• The Size option Tall (or Portrait) prints text across the short width of the paper.
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• The Size option Wide (or Landscape) prints text across the long width of the paper.
Brochures are only available in PrintMaster Gold Publishing Suite.

Select a Side to Edit
Brochures are made up of two separate sides comprising the front and back surfaces of the Brochure. Each side can have its own 
background, text, and picture elements. You can select the Brochure side you want to work on by selecting Front or Back in the View 
Side window at the bottom of the Workspace screen. Or, click one of the arrows on each side of the view side window.

Bright Idea: Try to imagine a grid when positioning elements in your document. This will enhance the overall feeling of order in 
your design.

Brochures typically are printed on both sides of the paper. To get more information on configuring PrintMaster Gold so your 
brochure project will print correctly, see the Double-Sided Printing section in the Newsletter Tutorial above.

Design Tips from the Pros
Don’t be afraid to stretch a photo or other design element out of the printing area and off the page. After printing, simply cut off the 
unprinted margin and you’ll have achieved a “full-bleed” effect. Pete Russitano - PrintMaster designer

Prioritize information in newsletters and brochures. Establish areas with current news ‘bites’ to highlight events or set off helpful 
tips. Breaking up longer, in-depth stories with shorter, fast-paced ones establishes a good information flow and helps keep the 
reader’s interest. Pete Russitano - PrintMaster designer

Letterhead
The Letterhead project can add style and a professional flair to all your business letters and personal documents. Our Ready Made 
Gallery of designs includes many styles, colors, and type fonts for you to choose from and personalize.

For more information on using the Ready Made Gallery, Art Gallery, and Workspace, see the Card Project Tutorial.

When creating a new Letterhead, you will be prompted to select a page layout for your new project. Use your mouse to select the 
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Letterhead Size.
• The Size option Tall (or Portrait) prints text across the short width of the paper.
• The Size option Wide (or Landscape) prints text across the long width of the paper.

Design Tips from the Pros
To make a letterhead picture lighter (to “screen” it), click on it, go to attributes, and choose a shade of gray. 30% will make a great 
background. Erin Donahue - PrintMaster Designer

Bright idea: To add something special to your letterhead, use specialized paper (graphite, glossy, marble, etc.)

Posters
The Poster project can be used to create page-size posters, flyers, bulletins, and certificates—or signs that cover an entire wall. The 
Ready Made Gallery also includes several blank Invoice forms.

For more information on using the Ready Made Gallery, Art Gallery, and Workspace, see the Card Project Tutorial above.

When creating a new Poster, you will be prompted to select a page layout for your new project. Use your mouse to select the Poster 
Size.
• The Size option Tall (or Portrait) prints text across the short width of the paper.
• The Size option Wide (or Landscape) prints text across the long width of the paper.

Enlarging your Poster
While printing, you can enlarge your poster up to 33 pages wide by 33 pages high. 
1. Create your poster as usual on one 8 1/2” x 11” page.
2. When you are finished, select Print. 
3. Select Output Size... You will then see the Custom Print Size dialog box.
4. Type in the number of pages wide or tall you want your poster to be. The text and graphics in your one-page project will be 
stretched to fit automatically.
5. Click Show to display the number of pages the project contains.
6. Click OK, then Print. Your project will be enlarged according to your settings and sent to the printer.
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Assembling Large Posters–Cutting and Taping Guides
PrintMaster Gold helps you assemble large posters by providing cutting and taping guides when you print multiple-page posters on 
8 1/2” x 11” single sheets.
• Cutting Guide: along the edge (or edges) of your printed pages, you will see continuous dotted lines. These are Cutting Guides. Cut 
along these lines to remove the excess edges.
• Taping Guides: near the edge (or edges) of your printed pages, you will also see short dashes. These are Taping Guides. Once you 
have cut off the excess edges (following the Cutting Guides), tape the adjoining sheets of paper, aligning to the Taping Guides. 

Note: Place the sheets with the Taping Guides under the sheets with the Cutting Guides.

Design Tips from the Pros
Limit the use of color and design elements to only those that are critical to deliver your message. One or two dominant colors 
complimented with softer muted tones are helpful. Also, it’s often not necessary to show all of the photos or images (if they are 
covered by others) to convey the desired effect. Pete Russitano - PrintMaster designer

If you are using more than one graphic image, try to pick art that is similar in style (or at least in color!). Erin Donahue - PrintMaster 
Designer

Banners
Nothing grabs attention like a PrintMaster Gold Banner! You can celebrate special occasions in style. We’ve included many Ready 
Made banners that include business, celebration, Welcome Home, and Grand Opening messages. Just fill in your particular 
information, and your words will make a big statement!

For more information on using the Ready Made Gallery, Art Gallery, and Workspace, see the Card Project Tutorial above.

Setting the Size of Your New Banner
When you open a new Banner project, you will be presented with one 8 1/2” x 11” page. There are a few methods to add pages to 
your banner:
• Edit Banner Text: Under the File menu, select Edit Banner Text. You will then see a blinking cursor on the left side of your banner. 
Type in the main phrase of your Banner. Pages will be added to fit to your phrase.
• Add Pictures: PrintMaster Gold will also stretch your banner’s width to fit a large picture. First, place a picture on your banner. 
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Then stretch your picture to the size you want. PrintMaster will add enough pages to your banner to fit the width of your stretched 
picture.
• Add Text Box: If you wish to set the size of your banner before adding text or pictures, add a text box to the banner and stretch it to 
the desired length. Once you’ve reached the desired length, delete the text box.

Enlarging your Banner
An easy way to create a large banner is to design your banner project on one page, and enlarge it during printing.
To enlarge your banner while printing: 
1. Create your banner project.
2. When you are finished, select Print. 
3. In the Print dialog, select Output Size... You will then see the Custom Print Size dialog.
4. Type in the number of pages wide or tall you want your banner to be. The text and graphics in your project will be stretched to fit 
automatically.
5. Click Show to display the number of pages the project contains.
6. Click OK, then Print. Your project will be enlarged according to your settings and sent to the printer.

Assembling Large Banners
PrintMaster Gold helps you assemble large banners by providing cutting and taping guides when you print multiple-page posters on 
8 1/2” x 11” single sheets.
+ Note: If you are printing on continuos-feed paper, you will not see (or need) Cutting and Taping guides.
• Cutting Guide: along the edge (or edges) of your printed pages, you will see continuous dotted lines. These are Cutting Guides. Cut 
along these lines to remove the excess edges.
• Taping Guides: near the edge (or edges) of your printed pages, you will also see short dashes. These are Taping Guides. Once you 
have cut off the excess edges (following the Cutting Guides), tape the adjoining sheets of paper, aligning to the Taping Guides. Note: 
Place the sheets with the Taping Guides under the sheets with the Cutting Guides.

Design Tips from the Pros
Try using graduated screens in the background of your banner, it will give it a feeling of depth. Erin Donahue - PrintMaster designer

Business Cards
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PrintMaster Gold makes it easy for you to create professional-looking business cards that will impress your friends and business 
associates. Our Ready Made Gallery of quiet, soft, flashy, and fun business cards makes it easy for you to get started. Just pick one, 
personalize it, and PrintMaster Gold will print out a page full of your cards ready to be cut and distributed.

For more information on using the Ready Made Gallery, Art Gallery, and Workspace, see the Card Project Tutorial.

When creating a new Business Card, you will be prompted to select a page layout for your new project. Use your mouse to select the 
Card Size.
• The Size option Tall (or Portrait) prints text across the short width of the paper.
• The Size option Wide (or Landscape) prints text across the long width of the paper.

+ Note: PrintMaster Gold business cards print on Avery 5371 Business Card sheets.

Note: The “Number of Cards” button on the Print dialog box defaults to the number of business cards printed on one page, not the 
number of pages to be printed.

Certificates
The Certificate project can be used to create your own official looking awards and it is great fun for creating gift certificates. We’ve 
provided many styles, including Merit Awards, Service Awards, Honorable Mentions, and fun awards for the whole family.

For more information on using the Ready Made Gallery, Art Gallery, and Workspace, see the Card Project Tutorial above.

When creating a new Certificate, you will be prompted to select an orientation for your new project.
• The size option Tall (or Portrait) prints text across the short width of the paper.
• The size option Wide (or Landscape) prints text across the long width of the page.

+ Note: Certificates can be expanded during printing. See Enlarging Your Poster in the Poster section above.

Design Tips from the Pros
For a more coherent look, try to stick with no more than three different point sizes for type. Erin Donahue - PrintMaster designer
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Envelopes
The Envelope project can add style and a professional flair to all your business letters and personal documents. Choose from several 
styles and sizes in the Ready Made Gallery, or create your own from scratch.

For more information on using the Ready Made Gallery, Art Gallery, and Workspace, see the Card Project Tutorial above.

Creating an Envelope
When creating a new envelope, you will be prompted to select a specific envelope size. From the list provided, choose an envelope 
size and click OK to begin editing.

Using Fill-in Fields with Envelope projects
You can add Fill-in Fields to your envelope projects and print out each with an individual’s name and address. For more 
information about Fill-in Fields, see the Adding Fill-in Fields to your label project in the Label Tutorial.

Printing Your Envelope:
Before printing your envelope, be sure to select the correct Envelope Feed option for your printer:
1. Select Print under the File menu (or press Command-P).
2. Click Envelope Feed... You will be presented with six options for placing your envelope in your printer. Check with your printer 
manual to see the proper way to insert an envelope into your printer’s sheet feeder.
3. Click OK. The Envelope Feed position you chose should be showing in the Envelope Feed window.
4. Click Print. Your envelope will print correctly.

Fax Covers
The Fax Cover project can be used to produce your choice of attractive Fax Covers. Choose from the many styles in our Ready Made 
Gallery and PrintMaster Gold will insert your name, company name, and address into the design.

For more information on using the Ready Made Gallery, Art Gallery, and Workspace, see the Card Project Tutorial above.
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When creating a new Fax Cover, you will be prompted to select an orientation for your new project.
• The size option Tall (or Portrait) prints text across the short width of the paper.
• The size option Wide (or Landscape) prints text across the long width of the page.

Using Fill-in Fields with Fax Cover projects
You can add Fill-in Fields to your Fax cover projects and print out each with an individual’s name and address. For more 
information about Fill-in Fields, see the Adding Fill-in Fields to your label project in the Label Tutorial above.

Note Cards
Use PrintMaster Gold to create your own business Note Cards to give out to work associates, friends, or family members.

For more information on using the Ready Made Gallery, Art Gallery, and Workspace, see the Card Project Tutorial above.

When creating a new Note Card, you will be prompted to select an orientation for your new project.
• The size option Tall (or Portrait) prints text across the short width of the paper.
• The size option Wide (or Landscape) prints text across the long width of the page.
Then select the location of the Note Card fold.
• The fold option Side places the Note Card fold on the left side of the Note Card.
• The fold option Top places the Note Card fold on the left top of the Note Card.

How To Fold A Note Card
With the printed side facing down, bring the top and bottom edges together and crease the fold. With the inside of the Note Card 
facing you, bring the left edge to the right edge (so that the Note Card front is now on top) and crease the fold.
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 Working with the Internet
PrintMaster makes it easy to get on the Internet. In this version of PrintMaster Gold, we’ve included two new utilities to help you 
browse the World Wide Web and send online greeting cards to your friends:

PrintMaster Gold’s Online Greetings. With PrintMaster Gold’s Online Greetings, after designing your Greeting Card, you can upload 
the card as a GIF file to the Internet for your friends or family to view. After you enter your Online Greeting information, we’ll send 
an email notification to both you and your receiver, letting you both know it’s ready. Your receiver can then go to the PrintMaster 
Gold web site listed in his or her email to view it.

+ Note: You will need to have an account with an Internet Service Provider, Compuserve, or America Online 3.0 (or later) to send 
an Online Greeting.

AT&T WorldNet Service. With the enclosed AT&T WorldNet Service, you are only a few easy steps away from hooking up to the 
Internet and browsing the World Wide Web. All you need is a modem and a telephone line. Just follow WorldNet’s step-by-step 
instructions to hooking up to the Internet. You can then go anywhere you want on the Internet or go directly to the PrintMaster 
Gold web site to get tips on using PrintMaster Gold, view projects made by other PrintMaster Gold users, and download additional 
free graphics to use in your projects.

+ Note: For Technical Support regarding AT&T WorldNet Service software, please call AT&T WorldNetsm Customer Care at 
1-800-400-1447 24 hours a day, 7 days a week.

To Access the Web
To access the Web, you need:
• A telephone line
• A modem, either 14.4 baud or faster
• An account with either an Internet service provider like AT&T WorldNet, EarthLink, or Spry.
• A World Wide Web browser—a program that lets you view web sites like Printmaster.com. Commonly used browsers are 
Netscape’s Navigator® and Microsoft’s Internet Explorer®.

User's Guide Page  51 Die, 5. Jul 2016
Chapter 7: Working with the Internet and Scanners



PrintMaster Gold comes with AT&T’s WorldNet Service, including both Netscape Navigator® and a setup program to easily start 
your Internet account with AT&T. All you need is a telephone line and a modem. 

To set up the browser and start your AT&T WorldNet account:
1. Open the AT&T WorldNet Service folder on the PrintMaster Gold CD-ROM. Click Install AT&T WorldNet. Follow the direction 
to configure your computer for Internet access.
2. In the installed AT&T WorldNet Service folder, double-click Account Setup. Follow the on-screen direction in the Account Setup 
Wizard. You will be asked to type in your credit card number (or call directly) to activate your account.
+ Note: For Technical Support regarding AT&T WorldNet Service software, please call AT&T WorldNet Customer Care at 
1-800-400-1447 24 hours a day, 7 days a week.

Sending Online Greetings
To send a greeting card to your friends and family with PrintMaster Gold’s Online Greetings:
+ Note: You will need to be connected through an Internet Service Provider, Compuserve, or America Online 3.0 (or later) to send 
an Online Greeting.
1. Create your card project and save it as usual.
2. While still in the Workspace, go to the File menu and select Send Online Greeting...
3. Enter your email address and the email address of your recipient. 
3. Click OK. Your greeting card will be uploaded to the PrintMaster Gold web site and an email notification will be sent to you and 
the recipient letting you know the card is waiting to be viewed. The recipient's email notification includes all the instructions 
needed to access and view the card.

Browse the PrintMaster Gold Web site
The PrintMaster web site offers several different ways to get information, tips, new art, and view projects created by other 
PrintMaster Gold users. Once you have launched your browser, and hooked up to the Internet, open the location 
www.printmaster.com from your browser. 

The content and look of the PrintMaster web site changes frequently, so you’ll want to check it often. Here are some of the things 
you might find there:
• Download free seasonal clipart, ready-made designs, and monthly calendars. 
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• Send a colorful, animated postcard to someone special.
• Get additional information on other PrintMaster products. 
• Purchase PrintMaster gifts and products in the Gift Shop. 
• Become a PrintMaster PubClub member and get access to PrintMaster Live, PrintMaster tips, software drawings, and much more. 

         Working with scanners
A scanner “reads” a printed picture as dots and translates (digitizes) those dots into a file called a bitmap that the computer can 
display and print. In other words, a scanner brings a picture of things ‘out there’ into the world of your computer. 

You control the scanning process from your computer, using a special software program that comes with your scanner. Most 
scanner software will ask you how many dots-per-inch you want to scan the image, whether you want a color or a black-and-white 
scan, or if you want only a part of the image you are scanning. See your scanner manual for more details.

Like most new scanners, PrintMaster Gold supports TWAIN technology so you can use your scanner from directly within 
PrintMaster Gold. The TWAIN support places your scanned picture directly on your project, so you don’t have to go from one 
program to another. 

Note: Not all scanners support TWAIN technology. Check your scanner manual to find out if your scanner supports TWAIN. 

To Acquire a scanned image using TWAIN:
1. From the Workspace, select Select Source under the File menu. Depending on your configuration, you may have more than one 
scanning source available. Select the source you want to use.
2. Click OK. TWAIN support is now configured for your selected input device.
3. Under the File menu, select Acquire... This will automatically launch your scanner software from within PrintMaster Gold.
4. Follow your scanning software’s directions for activating your scanner. 
5. After you have scanned the image, your image will be saved into Your Own  file in the Art Gallery. 

+ Note: PrintMaster Gold can read most bitmap formats including TIFF and BMP. PrintMaster Gold Classic cannot read 
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LZW-compressed files, but can be easily upgraded if this format is needed.

To acquire an image without TWAIN technology
1. Launch your scanner software.
2. Scan your image according to the directions that came with your scanner.
3. Save the file as a bitmap file (usually either TIFF or PICt). Remember where you saved the file.
4. Exit your scanner software and launch PrintMaster Gold.
5. Open the PrintMaster Gold Art Gallery and select Open From Disk under the Art Gallery’s File menu.
6. Select your scanned file. It will be added to Your Own  file in the Art Gallery. You can now place it into your projects as you would 
any other Art Gallery file.

Increasing PrintMaster Gold’s default memory size: If you are going to work with PhotoCD’s or scanned images, it’s a good idea to set 
the Size Resource to at least 24 Megs (or 32, if possible) by selecting the PrintMaster Gold Icon in the finder, select Get Info under the 
File menu and increase the Preferred Size to as large a number as you have memory space.

Setting Up TWAIN
PrintMaster Gold uses TWAIN technology to acquire pictures from your scanner, digital camera, or other TWAIN-compatible 
source, directly from within PrintMaster Gold.

If you have a TWAIN-compatible source, you will need to configure your computer before the Acquire and Select Source 
commands are available in PrintMaster Gold.

To install TWAIN technology software on your computer,
1. Follow the instructions from the manufacturer of your TWAIN-compatible device to install it’s TWAIN driver on your machine.
2. On the File menu of PrintMaster Gold, select Select Source to choose the device you want to use.
3. Click OK. 
4. Using the Acquire command (on the File menu) within PrintMaster Gold, you will now be able to bring in pictures from your 
TWAIN-compatible device.

Scanner Tips
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Keep your files small. Large bitmaps like color photos can slow your screen display considerably and will take up a lot of hard disk 
space.

You can control the dots per inch (dpi) that your scanner creates as it scans the picture. The more dots per inch your scanner reads, 
the more information it is storing, and the bigger the file will be. As a general rule, don’t scan at a higher dpi than your printer can 
print. In fact, scans often look best 50 to 100 dpi less than your printer can print (usually 300 dpi).

Remember that when you scan a picture, whether you found it in a magazine or a book from the library, the picture is someone’s 
original work and still belongs to them. If you intend to publish your PrintMaster project, you will need to get written permission 
from the artist or owner, even if you alter the picture beyond recognition.
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  Working With Text
Great-looking text can make the difference between getting read or being ignored. With PrintMaster Gold you can choose from a rich 
palette of text editing commands that let you modify any selected text with your choice of fonts, sizes, shapes, colors, and exciting 
effects.

This chapter provides step-by-step instructions that describe all aspects of working with text in PrintMaster Gold: adding text to your 
projects, editing text, changing text size and appearance, setting tabs, and linking text boxes.

Text Boxes
First, it is helpful to understand that all text in a PrintMaster Gold project is contained in text boxes. You can have as many text boxes 
as you like and they can be re-sized or arranged anywhere you want on the page. 

Text Box Handles
The boxes located at the corners and in the middle of each edge of the text box outline are called handles. They are used to re-size, 
position, and rotate a text box by clicking and dragging them with your mouse.

Selecting, Adding, and Removing Text
You’ll often want to change the appearance, size, or position of your text. Normally, the easiest way to select the text you want to 
change is to simply click on it with your mouse button. The selected text will be outlined within its text box.
1. Click the Text tool on the Add toolbar, then click once on your project. An empty text box will appear.
2. Press the Delete Key on your keyboard to remove the text box (from your project) or the currently highlighted text.

Editing Text
The fastest way to edit a specific section of text is to simply click on it. A cursor will appear within the selected text at the position 
indicated by your mouse. You can also select the text and modify it using the Text and Modify toolbars.
1. Click on the text you want to edit to begin editing.
A cursor will appear in the text box that has been selected for editing. The Text toolbar will display the font, size, and other options 
for changing the font attributes and text formatting of the selected text box.
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Tip: You probably already know about using an “oversize cap” or first letter with your text treatment. Now experiment with a 
different font—script characters can add a nice flourish of elegance. Also, try to embellish the oversize cap with a slightly different 
color and then add a subtle drop-shadow. Pete Russitano - PrintMaster Designer

Typing text in a new text box
As you type, the letters will appear in the upper left corner of the selected text box at the position indicated by the cursor.
• Press RETURN to move the cursor to the next line.
• Press the Spacebar to move the cursor one space to the right.

Typing text in an existing text box
Move the mouse pointer to where you want the text to appear, click once, and then start typing. The letters will appear at the 
position indicated by the cursor.
• Press DEL to delete the character to the right of the cursor.
• Press the Delete key to delete the character to the left of the cursor.

Selecting a section of text
You can delete, copy, or make font changes to a specific section of text within a text box by selecting the section of text you want to 
change.
1. Position the cursor to one side of the desired section of text using the mouse or the navigation keys (Up Arrow, Left Arrow, Right 
Arrow, Down Arrow, Home, END).
2. Drag the cursor across the section of the text you want to select using the mouse or by holding down the Shift key and extending 
the highlight using the navigation keys (Up Arrow, Left Arrow, Right Arrow, Down Arrow, Home, END).

Deleting, copying, and inserting selected text
1. Select (highlight) a section of text within a text box as described above.
• Press the Delete key to delete the currently selected (highlighted) text.
• Press Command+C or the Copy button on the Global toolbar to copy the selected text to the clipboard.
• Press Command+X or the Cut button on the Global toolbar to cut the selected text to the clipboard.
• Press Command+V or the Paste button on the Global toolbar to paste the copied clipboard text at the current cursor position.
For more detailed information regarding the standard Macintosh navigation and editing commands please see your Macintosh 
User’s Guide.
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Changing Text Attributes
PrintMaster Gold lets you change the attributes on a character-by-character basis of any selected text with your choice of fonts, point 
sizes, styles, colors, and special effects.
+ Note: Existing text must be selected (highlighted) before changing its attributes. 
The following font tools are available in the Text toolbar:
Font—Use this option to choose the font you want applied to the currently selected text.
1. Use the scroll bars or the Up Arrow or Down Arrow keys to scroll through the list of available fonts.
2. Click the font you want to confirm your selection.
+ Note: PrintMaster recognizes all True Type fonts installed on your system, making them available along with PrintMaster Gold’s 
font set.
Size—Use this option to choose the size you want applied to the currently selected text.
1. Use the scroll bars or the Up Arrow or Down Arrow keys to scroll through the list of available sizes, or type in any size up to 1000 
points.
2. Click the size you want to confirm your selection.
Bold, Italic, Underline—Use these buttons to choose the style you want applied to the currently selected text.
1. Click on either the Bold, Italic, or Underline buttons on the Font Toolbar.
Some decorative fonts (e.g. Burlesque, Opera, Showtime, etc.) do not have a Bold or Italic variation and cannot be altered.
Shape—Use this option to change the shape of all the text in the selected text box.
1. Use the mouse or the arrow keys to select the desired shape.
2. Click the shape to confirm your selection.
Stretch—Use this option to stretch the text in the selected text box to the text box’s limits.
1. Select the text box. Click the Stretch button on the Text toolbar. All of the text in the text box will be stretched to the limits of the 
text box.
The following text formatting buttons are available on the Modify toolbar:
Color—Use this option to choose the color you want applied to the currently selected text.
1. Click the Font Color button to bring up the color selection menu.
2. Use your mouse or the arrow keys to scroll through the list of available colors, or click More... to select a custom color.
3. Select the color you want by clicking on it.
Line Width—Use this option to choose the outline width of the currently selected text.
1. Click the Line Width button on the Modify toolbar. Use the arrow keys to scroll through the list, or click More... to select a custom 
line width.
2. Select the color you want by clicking on it.
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Line Color—Use this option to choose the color you want applied to the outline of the currently selected text.
1. Click the Line Color button on the Modify toolbar.
2. Use your mouse or the arrow keys to scroll through the list of available colors, or click More... to select a custom color.
3. Click the color you want to confirm your selection.
Shadow—Use this option to choose the shadow for the currently selected text.
1. Click the Shadow button on the Modify toolbar. Use your mouse or the arrow keys to scroll through the list of examples.
2. Click the shadow you want to confirm your selection.
Shadow Color—Use this option to choose the shadow color of the currently selected text.
1. Click the Shadow Color button on the Modify toolbar.
2. Use your mouse or the arrow keys to scroll through the list of available colors, or click More... to select a custom color.
3. Click the color you want to confirm your selection.
+ Note: Existing text must be selected (highlighted) before changing its attributes.

Character Spacing
PrintMaster Gold allows you to easily change the spacing between letters in your projects, loosening (widening) the space between 
letters for headlines and mastheads, or tightening (narrowing) the space between letters for text in small spaces and custom looks.
To change the spacing between letters in a text box,
1. Select text you want to change.
2. Select Character Spacing... under the Format menu.
3. Select the character spacing for your selected text. The Preview window will show you an example of your selection.
4. After you have selected the character spacing, click OK. The spacing will then be applied to the selected text in your project.

Paragraph Formatting
PrintMaster Gold allows you to set custom margin and line space settings on each of your text paragraphs. Within any text box, you 
can set left and right margins, choose the alignment of the paragraph, add or subtract line spacing (leading), or add spaces before or 
after the paragraph.
1. Select the paragraph you want to format.
2. Select Paragraph under the Format menu. The Paragraph Formatting dialog will appear.
3. Click OK to apply the new formatting to the selected text.
Indentation—type in the inches (or fractions) you want to indent the left, right or first line of the selected text within the text box.
Line Spacing—Type in the number of Lines or Points you want between each line of text in the selected paragraph. The Line space 
will change with the size of the selected type (the larger the font size, the larger the space between the lines). The Point size is a 
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specific unit of measurement used by typesetters. The standard size of text in books and letters is usually 10 to 12 points, with an 
extra 2-4 points between each line (for a total of 12-16 points Line Spacing).
Paragraph Spacing—type in inches (or fractions) you want added before or after each selected paragraph.

Text Box Formatting
In PrintMaster Gold, you can format an entire text box, so all text typed into it responds to your settings. You can set text box 
margins, set the number of columns in the text box, the spacing between the columns, the alignment of all text within the text box, 
and the shape of all text within the text box.
To format all the text within a text box,
1. Select the text box you want to format. The handles will show around its frame.
2. Select Text Box under the Format menu.
Margins—type in the inches (or fractions) you want to indent the left, top, right, or bottom of all the text within the text box.
Columns—type in the number of columns and the amount of space (in inches or fractions of an inch) you want between the 
columns.
Vertical Alignment—select Top Aligned, Middle Aligned, or Bottom Aligned to align all text within the text box.
Shape—using the mouse or arrow keys, select a shape for all of the text within the text box.
3. Click OK to apply your formatting to all of the text in the selected text box.

Text Wrap
You can make newsletters and other projects look professional by wrapping text around pictures or other text boxes.
1. Select the text box or picture you want text to wrap around.
2. Select Text Wrap under the Arrange menu.
Text Flows Over—select this button if you want text to flow over (or under, if the text box is a lower layer) the selected text box or 
picture. This is the default setting for all pictures and text boxes.
Text Wraps Around—select this button if you want text to flow around the selected text box or picture.
3. Click OK. 
+ Note: The Text Wraps Around Feature will only work on text boxes with Top Alignment (See Text Box Formatting above for 
more information).

Setting Tabs
PrintMaster Gold enables you to control the positioning and alignment of tabs stops and determine the type of leader characters 
used. To access the tab control dialog, pull down the Format menu and click Tabs. This menu item is only available while you are 
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editing text.
Position—Use this option to create a new tab stop by entering a numeric value (in inches) in the space provided, and click Set.
• To set a tab stop for the selected text, enter a numeric value (in inches) in the space provided across from Position, and click Set.
• To clear a tab stop, highlight the tab stop from the Tab Stops list and click Clear.
• To clear all custom tab stops in the selected text, click Clear All.
Default Tab Stops—Use this option to set the default spacing between tab stops by entering a numeric value in the space provided.
Alignment—Use this option to create left- and right-aligned tabs, center tabs (which center text around the tab) and decimal tabs 
(which align characters at a value you provide). Once you have made your selection, click Set and the tab alignment will be applied 
to the selected text box.
Leader—A leader is a repeated pattern, such as a series of dots or dashes, between the tab and the preceding text. Use this option to 
fill the empty space to the left of a tab stop with a leader character. Click either the solid line item, or choose Custom and type in a 
series of characters (examples: … , _ _ _ , < < <, etc.). Once you have made your selection, click Set and the tab leader setting will be 
applied to the selected text box.

Linking Text Boxes
PrintMaster Gold provides you with the ability to connect or “link” multiple text boxes of varying sizes and shapes together any 
where on your project. This feature enables your text to flow from one text box to another as you type.
1. Click the Text button on the Add toolbar and click once on your project to place a new text box on your project. Repeat this step to 
as many times as necessary to add the desired number of text boxes to your page.
2. Use your mouse to click on the link button located on the bottom-right of your text.
Note that your mouse pointer no longer appears as the standard arrow pointer.
3. Next, move your mouse pointer over to the second text box and click on it.
Once you have linked the first two text boxes together, you can then add a third by clicking the link button located at the bottom of 
the second text box and clicking in the center of the next text box. Repeat these steps for adding a fourth text box and so forth.
4. Return to the first text box in the link and begin typing your text. As your text fills the first text box, it will then “flow” over to the 
second. This “flowing” of text will continue on to any other text boxes in the linked chain of text boxes.

Unlinking Text Boxes
To unlink two connected text boxes:
1. Click on the first text box you would like to unlink. The text box will display a Next Text Box button (right arrow), showing that it 
is connected to another text box.
2. Click the Link button. The cursor will again turn into the Text Pour icon.
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3. You can then either:
• Click inside the text box, unlinking that text box from all following boxes. The text will now stay within that text box, or 
• Click into another empty text box, linking the text to the new text box.

Applying Font Effects
PrintMaster Gold provides many different ways to format your text, including colors and shadows, as well as radial, whirl, plaid, and 
percent gray fills.
To apply an effect to your fonts,
1. Select (highlight) the text you want to change.
2. Under the Format menu, select Font. You will see the Font Format dialog.
3. Click the Effects tab at the top of the dialog.
4. Select the Fill Pattern, Outline, or Shadow and color for the selected text. You can see a preview of your selection in the preview 
window.
5. Once you have made your selections, press Return or click OK. Your font effect selections will be applied to your selected text.
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  Working With Pictures
PrintMaster Gold makes it easy to add pictures and shapes to your projects. You can have as many pictures or shapes as you like, and 
they can be resized or arranged anywhere you want on the page. Most pictures and shapes included with PrintMaster Gold can be 
stretched, rotated, and scaled up to 6 feet with no loss of detail.

+ Note: PrintMaster Gold works with all popular graphic formats: PCX, TIF, GIF, JPG, CGM, BMP, DIB, and Kodak Photo CD.

Selecting and Adding Pictures & Shapes
You’ll often want to change the appearance, size, or position of an existing picture or shape. The easiest way is to select the item you 
want to change by simply clicking on it with your mouse button. The selected picture or shape will then be highlighted with a frame 
and handles.

The squares located at the corners and to the right of each frame are called handles. Handles are used to resize, position, and rotate a 
picture by clicking and dragging with your mouse.

Picking by opacity: When you click on a picture, make sure you click on an opaque section of the image. If you click on a clear or 
transparent part of the image, you will most likely select the object underneath it.

Adding a New Picture
1. Add a new picture to your project by clicking the Art Gallery button on the Add toolbar in the Workspace.
 Or, from the Hub screen, click on the Art Gallery button.
2. Choose a Category, Tone, Style, or Media of picture you want. Or, type in a keyword and let PrintMaster Gold search for all the 
pictures that match your request. 
3. Highlight a picture by clicking on its preview. Scroll down the preview area to see more pictures that fit your criteria.
+ Note: use the star (“*”) wildcard to find all versions of the word you are searching for. For example, “Fish*” will find not only 
“Fish”, but “Fishing” and “Fisherman”.
A larger sample of a highlighted preview can be seen by selecting View Medium or View Larger from the View Size window popup.
To return to the standard preview click View Small on the View Size window popup.
4. Choose a picture by clicking on its preview. Confirm your choice by clicking Select (or, double-click on the preview).
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Besides providing a large collection of pictures from which to choose, PrintMaster Gold allows you to select pictures from another 
drive or folder.
1. To open a picture from another location while in the Art Gallery, pull down the File menu (on the Art Gallery menu bar) and 
select Open From Disk....
2. Choose the picture location by selecting the drive and folder. Select a picture by clicking on its name in the File Name list—a 
preview of the highlighted picture will appear to the right.
3. Click the OK button or press Return to open the selected picture.
+ Note: PrintMaster Gold can import many different types of graphic formats, including CGM, TIFF, PSD, JPG, PCX, GIF, and Kodak 
Photo CD.

Picture Properties
Periodically, it can be useful to know the name, file format, and keywords associated with a picture in the Art Gallery or a preview 
in the Ready Made Gallery. 
To get more information on pictures in Art Gallery,
1. Select the picture preview
2. Select Properties in the Art Gallery File menu.
To get more information on the Ready Made preview in the Ready Made Gallery,
1. Select the preview.
2. select Properties in the Ready Made Gallery File menu.
File Name—the name and file format of the preview or picture
Description—the title of the preview or picture
Keywords—the keywords associated with the preview or picture

Save Copy of File in Document
This function embeds a copy of the picture files used in your project within the document itself so that the original picture file is not 
required the next time you open your project.

This feature is particularly useful when using pictures that are selected from a floppy disk or CD-ROM. When selected, PrintMaster 
Gold will not require you to insert the floppy disk or CD-ROM containing the picture(s) used each time you open your project.

Adding a New Shape
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1. To add a shape to your project, click the Shape button in the Add toolbar.
2. Use your mouse or arrow keys to highlight a desired shape on the provided list. 
3. Click on your desired shape. Your cursor will turn into a cross-hair.
4. Click the cross-hair cursor anywhere on your project and the shape will appear. Or, drag the cross-hairs across your project and the 
shape will be drawn to the width and height of your mouse drag.

Resizing a Picture
You can quickly size a picture by clicking on one of its frame handles with the mouse and, while holding the button down, drag the 
handle to the desired location. The mouse arrow pointer will change to a double arrow when you are resizing a picture. Release the 
mouse button when the picture has the proper size and shape. The picture will expand or shrink to fit the new frame size. 

Sizing Tip #1: Hold down the Shift key while dragging to make the new size proportional to the original picture size. Hold down 
the Control  key while resizing in order to keep the new size proportional to the current picture size.

Replacing Pictures
You can easily replace a picture on your project with another in the Art Gallery or from another location. When you replace the 
picture, other properties of the selected picture such as the color, center position, and flipping are not changed.
1. Select the picture you want to replace. Click Replace Picture... under the Edit menu and the Art Gallery will appear.
2. Choose the new picture from the Art Gallery and click Select or press Return.
PrintMaster will return to the Workspace with the new picture on your page.

Picture Attributes
The Attributes editing command is used to change the printing attributes of the currently selected picture. This option is available 
from the Format menu, or on the pop-up menu which is activated by the right mouse button.

The Render Method and Coloring Book options can be selected in this dialog. Some options may not be available for certain types of 
pictures and may be “grayed out”. In general, the Render Method option applies to pictures in a bitmapped format such as TIF or 
PCX. The coloring book option is available for CGM pictures.

Use Render Method to adjust the way PrintMaster combines colored dots to simulate color shading and gray tones in bitmapped 
graphics. Most bitmapped graphics have more colors or grays than the output device (screen or printer) is capable of showing. 
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PrintMaster Gold uses two methods to approximate those colors as well as possible on an output device. For example, consider an 
image with 256 colors on a printer that supports only 16 colors. PrintMaster makes the 256 colors appear by mixing the 16 colors 
available.

The general name for processing an image for the screen or printer is “rendering”. The specific rendering methods available in 
PrintMaster Gold are Ordered Dither and Error Diffusion.

An Ordered Dither uses a fixed set of patterns to blend colors. Each color or gray in the image changes to a pattern of colors on the 
output device. The appearance of the resulting image is very regular.

Error Diffusion on the other hand, is a dynamic process. It creates patterns “on-the-fly”, and the resulting patterns tend to be more 
dense and unique. Images often look better with Error Diffusion, though the patterns look very unusual when viewed up close. 
Also, because Error Diffusion patterns are more dense, the image tends to darken due to bleeding of ink or toner when the image is 
printed. This means that if you use Error Diffusion, you will probably also need to adjust your printer contrast to lighten the image.

Select Coloring Book to print only the outline of the selected picture, with the color fills printed as white. The final printout can be 
colored using crayons or pens.

Picture Color
The color of a selected picture can be changed by clicking Attributes under the Format menu. 

Select a color by clicking on its name. More... lets you pick colors from the Macintosh Color dialog or define your own custom RGB 
colors (See your Macintosh User’s Guide for more information on the Macintosh Color Picker).

Most of the pictures included with PrintMaster Gold contain many different colors. What happens when you change the “color” of 
these pictures? The answer is that PrintMaster will change all the black parts of the picture to the selected color. The other colors in 
the picture may get lighter, darker, or change hue depending on the original picture color and the color to which the picture is 
changing. Only pictures which are all black will completely change to the selected color.

Color Tip #1: Selecting the color black restores a picture to its original color.
Color Tip #2: To “lighten” a picture without changing its original color, select one of the gray scale percentages (colors 65 to 84). This 
is a good way to reduce the print density when you use a dot matrix printer. It also allows you to lighten any picture for use as a 
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softer background. A picture with fine lines or details may appear less sharp whenever you change its color or lighten it with a gray 
shade.
Color Tip #3: Colors may look different on the screen than they do when printed. Make a Poster project using the colors you’re 
interested in, then print it out and keep it as a reference chart.

Tip: Soft, muted colors are an important way to achieve subtle feelings in a design. They can soothe, warm, soften, add elegance and 
emotion, and be a welcome departure from the bright, jarring images of the day. Pete Russitano - PrintMaster designer

Positioning and Grouping Text and Pictures
This chapter provides instructions on the PrintMaster features that apply to both text and pictures, like rotating, moving, 
positioning, layering, grouping, ungrouping, flipping, and duplicating.

Rotating Text Boxes and Pictures
You can quickly rotate a text box or picture by clicking on its rotation handle with the mouse and, while holding the button down, 
drag the handle to the desired location. Release the mouse button when the text or picture is in the proper orientation. The mouse 
pointer will change to a curved arrow when you are rotating.

Rotation Tip: Hold down the Shift key while dragging to restrict the rotation to increments of 45°.

+ Note: The rotation feature is only available for some graphics.

Positioning a Text Box or Picture
Using the Mouse: The most natural way to position a text box or picture is to click on the text box or picture between the handles (on 
its frame) and, while holding the button down, drag the frame to the desired location. Release the mouse button when the frame 
has been properly positioned.

Using the Position menu: You can also move and size a text box or picture by using the Position menu. Access the Position menu by

User's Guide Page  67 Die, 5. Jul 2016
Chapter 9: Working with Pictures



• Go to the Arrange menu and choose Position, or
• Click the Position popup window at the bottom of Workspace screen
This command will bring up the Position menu containing options for placing the currently selected text box in predefined 
locations.

The following positioning (and sizing) options are available:
Center on Page centers the selected text box or picture both horizontally and vertically on your project page.
Center Horizontally centers the selected text box or picture width (left to right) of the project page.
Center Vertically centers the selected text box or picture to height (top to bottom) of the project page.
Full Page resizes the selected text box or picture to the full height and width of the project page.
More... brings up the Position dialog, which lets you set the horizontal and vertical positioning independent of each other as well as 
width and height. Choose a standard horizontal or vertical position, or type in a specific position. 
Click Reset to return a modified text box to its last position and size on your project page.
Size lets you set the width and height independent of each other. Choose a standard width or height, or type in a specific size. 
Click Reset to return a modified text box or picture to its last position and size on your project page.
Click OK to confirm.

Flipping Text Boxes and Pictures
Select the Mirror button in the Place toolbar to flip the selected text box or picture horizontally.

Select the Flip button on the Place toolbar to flip the selected picture vertically.

Duplicating Text Boxes and Pictures
The Duplicate option is a quick and easy way to make a copy of an existing text box or picture. To make a duplicate of an existing text 
box or picture, proceed as follows:
1. Select the text box or picture to be duplicated by clicking on it.
2. Click Duplicate under the Edit menu.
3. Select the duplication position you want to use by clicking on its name. A preview of the duplication pattern will appear to the 
right.
The initial selection (Single duplicate), will create a single duplicate of the selected picture or shape. Other duplication positions 
create multiple copies of the selected picture or shape which are collected into a group.
4. Click OK or press Return to confirm your selection. PrintMaster Gold returns to the Edit Picture menu with the duplicate picture 
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selected. 

Layers
Text box and picture elements in a PrintMaster Gold project are like a deck of playing cards, each element has its own position or 
layer in the deck and each element can hide the elements under it, or be hidden by the elements above. PrintMaster allows you to 
“shuffle” the layering order of your text boxes and pictures to move selected elements in front of or behind others. Individual text 
boxes can be placed in front, back, or anywhere in between.

To change the layer of the selected text box or picture, use the following buttons in the Place toolbar:
 The Send to Front button moves the selected text box or picture to the first layer, in front of all other text boxes and pictures.
 The Forward One button moves the selected text box or picture forward a layer.
 The Back One button moves the selected text box or picture back a layer.
 The Send to Back button moves the selected text box or picture to the last layer, in back of all other text boxes and pictures.

Any Layer options that do not apply to the selected text box or picture will be disabled. For example, if a selected text box is already at 
the front, then Bring to Front will be “grayed out”.

Grouping Text Boxes and Pictures
Sometimes you’ll have a combination of text boxes and pictures that need to remain positioned relative to each other. The 
Grouping option makes it easy for you to manage multiple text boxes and pictures that are related by combining them in a single 
group. In this way, you can flip, duplicate, and move all of them at the same time.
1. Use your mouse to select the text boxes and pictures you want to group together while holding down the Shift key.
2. Click the Group button in Place toolbar.
3. To ungroup, simply select any member of the group and click the Ungroup button in the Place toolbar.
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  Printing a Project
No matter how good your project looks on the screen, the final printout on paper is what really counts. PrintMaster Gold pulls out 
all the stops to make sure your printed project will look its best.

Full 24-bit rendering that supports more that 16 million colors or shades of gray means your pictures will look spectacular. And 
since all text and pictures are fully scalable, you’ll always get crisp razor-sharp output. Plus, PrintMaster Gold lets you print your 
project at any size—from a miniature greeting card to a gigantic garage door poster.

This section provides step-by-step instructions for printing your project and optimizing your printing setup.

Print Project in the Workspace
To print your project, proceed as follows:
1. Click the Print button on the Global toolbar (or Select Print under the File menu). 
2. Confirm that the current settings are correct. For more information, see the next section entitled Print Settings.
3. Click Print to start the printing process.

Print Settings
The Print dialog allows you to easily choose and configure your printer, select the output size and print options for your project, and 
set number of copies to print. This section provides detailed instructions for each of the Print dialog options.

+ Note: PrintMaster performs full 24-bit rendering of pictures before sending the data to the printer. In addition, any intensity 
controls supported by the driver will probably have no effect on the output from PrintMaster Gold.

Print Quality
Most printers support a number of different print quality choices. Click on the Print Quality list box to make your selection. 
Generally, a low resolution or low quality setting will result in faster printing times—useful for printing a quick rough draft or a 
very large project that will be viewed from a distance. A high resolution or high quality setting will give you the best output, but 
will probably take longer to print—use high quality for your final printout.

Copies
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Use this item to select the number of copies you want to print. Simply enter the desired number into the box next to the word 
Copies. The number of copies is reset to 1 after each printout.

+ Note: When you print, you will see both the PrintMaster Gold Print dialog, then the standard Macintosh Print dialog. Only the 
number of Copies in the PrintMaster Gold Print dialog will be used.

Check the Collate Copies item in order to print one complete group of your project before printing the next copy. 

Note: Collate copies is only available in Business Card, Label, and some Matching Set projects.

Fill-in Fields...
Use this option to merge fields from your Address Book onto your printed projects. This time saving features enables you to print 
out envelopes, labels, invitations or other projects with the names and addresses of family, friends, or business associates. (See 
Adding Fill-in Fields to your project.)

Output Size...
PrintMaster Gold lets you take some projects and print it at any size, from as small as a postage stamp to as large as a garage door.
1. Click the Output Size button. The Custom Print Size dialog will appear.
2. Enter the desired output size into the dialog fields. A project whose output size is larger than a single sheet of paper will be 
printed on multiple sheets—each sheet is called a tile. As you select the output size, click the Show button to display a preview of 
the tile pattern making up the final printout. When your project has finished printing, assemble the tiles to create the final printout.

There are five items you can change in the Custom Print Size dialog. Note that all sizes must be proportional to the project size. If 
you change the height, then the width is automatically adjusted and vice versa.
• Inches Wide specifies the output width in inches.
• Inches Tall specifies the output height in inches.
• Sheets Wide specifies the output width in multiple sheets of paper. (Most commonly used to print posters and banners).
• Sheets Tall specifies the output height in multiple sheets of paper. (Most commonly used to print posters and banners).
3. Click OK to confirm your selections, or click Cancel to return to the Print dialog without changing the output size.
 The output size of each printed project is reset to 100% after each printout.

Which Tiles...
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For small printouts that fit onto a single tile (sheet of paper), the button is disabled. For large printouts that require multiple tiles, 
use this option to individually select the tiles to be printed.
1. Click the Which Tiles... button. The Tiles to Print dialog will appear.
2. Select the tiles you want to print from the preview windows. Click on a tile to select it, and click on a selected tile to deselect it.
• Click Turn All On to select all tiles.
• Click Turn All Off to deselect all tiles.
3. Click OK to confirm your selections, or click Cancel to return to the Print dialog without changing the tile selections.
The selected tiles item in each printed project resets to “all tiles” after each printout.

Coloring Book
PrintMaster lets you print certain types of pictures as they would look in a coloring book: only the picture outline is printed and all 
color fills are printed as white. The coloring book option can be set on a per-picture basis. Selecting the Coloring Book option in the 
Print Dialog overrides these individual settings as follows:
• None turns off all coloring book printing regardless of the individual picture settings.
• As Selected (the default) performs coloring book printing according to the individual picture settings.
• All turns on coloring book printing for all appropriate pictures.
Only certain types of pictures can be printed with the coloring book feature. This includes the majority of pictures provided by 
PrintMaster and the Clip Art Library, or any other picture in the CGM graphics formats. For other formats such as TIF or PCX, the 
coloring book option will have no effect.

Smoothing
Use the smoothing option to soften the roughness of low resolution bitmapped graphics on your printouts. To turn smoothing on 
and off, simply click in the checkbox next to the word Smoothing.

In general, only pictures in bitmapped graphics format such as TIF or PCX are effected by the smoothing option. Smoothing has no 
effect on the pictures provided by PrintMaster Gold, or any other picture in the CGM graphics format.

Advanced...
Click the Advanced... button to display the Advanced Settings dialog.

Use the Outline Picture Contrast slider to adjust the lightness or darkness of printed outline pictures such as CGM and WMF 
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graphics. Use the Bitmap Picture Contrast slider to adjust the lightness or darkness of printed bitmap pictures such as graphics in the 
TIF or PCX formats.

Picture Contrast does not effect text or other items such as Calendar lines. If pictures are printing too dark, adjust the slider to the 
left, towards the word Light. If pictures are printing too light, adjust the slider to the right, towards the word Dark. A setting of 1000 
will cause PrintMaster to send pictures to the printer without any contrast adjustments.

Dot matrix and HP DeskJet printers can sometimes print too dark or too light. Use the Picture Contrast controls to lighten or darken 
the printout.

Printer Alignment
PrintMaster Gold includes several tools to align and print your project correctly on the page. However, it is possible your project 
may not be properly aligned on the paper, printing too far to one side.

Use the Print Alignment feature to correct the problem:
1. Make sure your printer is ready to print with a clean sheet of paper, either in the paper tray or the manual feed tray.
2. Select Print Alignment under the File menu or from the advanced setting dialog window.
3. In the dialog, choose the type of printout you want to correctly align.
4. Print the Print Alignment Test Page by clicking the Print Test Page button.
5. On the printed test page, measure the items requested in the dialog box and enter the values (in inches) into the corresponding 
boxes.
6. Click OK. PrintMaster Gold will realign its settings so your project will now print correctly.
Click Reset to return to your printer’s default settings.

Printing Labels
To print your Labels, proceed as follows:
1. Click the Print button on the Global toolbar (or under the File menu).
These instructions may also be applied to the printing of Business Cards.
2. Click Print to start the printing process.

Starting Label...
Use this item to specify the starting label on any printout. This feature is useful when printing to a page containing only a partial 
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number of labels. On printouts consisting of multiple pages, this feature will only apply to the first page. Any additional pages will 
start printing on the first label.
1. Click the Starting Label... button.
2. Choose the starting label and click OK.
3. Enter the number of copies you wish to print.

+ Note: The “Number of Labels” defaults to the number of labels printed on one page (not the number of pages printed).

Printing Envelopes
To print your Envelope, proceed as follows:
1. Click the Print button on the Global toolbar (or under the File menu). The print dialog will appear.
2. Click Print to start the printing process.
Envelope Feed...
Use this item to indicate the position of your envelope as it is inserted into the paper tray.
 Tall/Wide indicates which edge of the envelope is fed first into the printer.
 Left/Center/Right indicates the positioning of the envelope along the paper feed path.
 Flap Up/Flap Down indicates which way the envelope flap faces when it is fed into the printer.
 Rotated changes the orientation of the envelope feed by 180 degrees.
 Reverse Landscape switches the envelope orientation by rotating the envelope by 180 degrees and switching the envelope feed to 
the other side of the tray. Use this option only if your printer seems to be printing opposite of were the envelope is actually being 
fed.

Note: If you have a Hewlett-Packard DeskWriter, be sure the reverse Landscape box is checked.

Printing Project Previews from the Ready Made Gallery
You can print project previews directly from the Ready Made Gallery. This can be useful when you want to show different examples 
to others before finalizing your project.
To print out Project previews,
1 Open the Project Gallery by clicking on the Ready Made button in the Workspace or in the Hub.
2. Select Print in the File menu of the Ready Made Gallery. The Print Project dialog will appear.
Print Selected Project—will print out only the preview selected (that is, the preview surrounded by a gray box in the preview area).
Print Current Page—will print the previews showing in the preview area.
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Print All Projects—will print all previews selected according to your search criteria.
Number Per Page—will print the number of thumbnail previews you select per page, sizing each preview to as large as possible on 
the page within those settings.
3. Click Print to print your Ready Made previews.

Print Picture Catalog...
PrintMaster Gold allows you to print out a catalog of your favorite pictures on your hard disk or graphic CD-ROMs.
1. Click Print Picture Catalog... under the File menu. A dialog box will appear.
2. Locate the pictures you want to print.
3. Select the picture or pictures you want to print, then select Add. The pictures will be added to your print list.
4. Click Print. You will then see the PrintMaster Gold Print dialog.
5. Choose the number of images you want printed on each page.
6. Click Print.

Preferences and Window Arrangement
PrintMaster Gold offers you several ways to customize your working environment.
Sound Effects

To turn on or off the sound effects that accompany many mouse clicks, 
1. Select Preferences under the file menu.
2. Select the Sound Effects tab at the top of the Preferences dialog.
3. Select On or Off.
+ Note: The Sound settings can also be changed from the Sound menu.

Welcome Dialogs
To turn the PrintMaster Gold voiceover dialogs off as you enter each new area,
1. Select Preferences under the file menu.
2. Select the Welcome Dialog tab at the top of the Preferences dialog.

User's Guide Page  75 Die, 5. Jul 2016
Chapter 10: Printing and Preferences



3. Select Sounds On or Sounds Off.
If you have turned off some of the Welcome Dialog boxes by clicking the “Don’t Show This Again” box (at the bottom of each 
Welcome Dialog) and want to turn them all back on, click the Reenable all Dialogs button.

Workspace Preferences
Since your hard disk is faster than your CD-ROM player, PrintMaster Gold improves performance by using a file on your hard disk 
to store the most frequently used information. This hard disk file is called the workspace file.

To change the workspace size click on the File menu with your mouse, select Preferences, and choose the Workspace tab.

Use your mouse to change this value and type in a new workspace size.
• A larger workspace uses more hard disk space but enables you to access fonts and graphics far more quickly.
• A smaller workspace uses less hard disk space but takes longer to access the fonts and graphics.
Note: The Preferences dialog can be accessed from within the file or sound menus.

Window Arrangement
PrintMaster Gold allows you to work on several projects at once in the Workspace. This can be beneficial if you want to trade 
graphics back and forth between projects, or view a letterhead design as you work on its matching envelope.
To change the window views while in the Workspace, select the Windows menu.
Cascade—overlaps the different windows so you can see a portion of each.
Tile—moves each window side by side and reduces it accordingly to fit in the Workspace.
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       Macintosh Troubleshooting
If you are having trouble running PrintMaster Gold, try the following procedures before contacting Mindscape Technical Support.  
The steps outlined will allow you to remove the program without removing any saved files you have created.  If the program is 
completely removed, your saved work will be lost.  Please use caution when following the steps outlined.

+ USE EXTREME CAUTION when making changes to your system.  If you're uncertain how to modify your system or system files, 
please consult the "troubleshooting" section of your Macintosh documentation, or contact the appropriate hardware manufacturer.  
If at any time you feel uncertain about directions listed below or have any questions concerning your system, contact Apple at 1 (800) 
SOS-APPL or 1 (800) 767-2775.

Although we have made every effort to anticipate problems you're likely to encounter, Mindscape, Inc. cannot be responsible for the 
results of changes you make to your system's configuration files. 

1. Verify the programs system requirements against the system requirements found at the beginning of the manual.  At the Desktop, 
click on the Apple Icon in the upper left hand corner  and select About This Macintosh.  

A. Largest Unused Block indicates the amount of free memory available to run applications.
B. System Software indicates the version of the operating system.  (Note:  If another application appears above System Software, go 
back to the Finder, select the application, click File in the menu bar, and select Quit.

2. Clean the CD on the shiny side (where there is no text or label) with a clean soft cloth (preferably a T-shirt).  Wipe gently from the 
center to the edge in straight lines.   If you use a damp cloth, make sure the CD is completely dry before you put it in the CD-ROM 
drive.

3. Check the Memory settings in the Control Panel.  Click on the Apple Icon in the upper left hand corner and select Control Panels 
> Memory.  

A. There may be an option for 32bit Addressing.  If this option is available, make sure it’s turned “On”.  Restart the computer (if the 
change is necessary) for the change to take effect.
B. All system types will have an option for Virtual Memory.  If this option is “Off”, try turning Virtual Memory “On” and setting it 
to at least 2 megs of hard drive space.  Virtual Memory will take a portion of your hard drive and use it as actual RAM which may 
result in slower performance with some applications, but may enhance others. Restart the computer (if the change is necessary) for 
the change to take effect.
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4. Check the color and resolution settings of your monitor by clicking on the Apple Icon in the upper left hand corner, select Control 
Panels and click on the Monitors (or Monitors & Sound) option.  If you are running “Thousands” of colors, you may want to try 
running 256 colors.  Click on the “Options” button and click on a resolution of 640x480 and click “OK”.  These are standard options 
and may resolve any display issues.

5. Click on Special in the menu bar and select Restart.  After you hear a tone from the computer, hold down the Option and Apple 
keys until you see a window asking:
“Are you sure you want to rebuild the desktop file on the disk ‘Macintosh Hard drive’?  Comments in info windows will be lost.”

Let go of the Option and Apple Keys and click OK.  It is important to press this key combination before the “Welcome to Macintosh” 
screen appears or you will not see this dialog.  Once the computer finishes booting, drag the program’s folder and preferences to the 
trash and reinstall.  If the problem persists, there may be an extension conflict.

A. To delete Preferences, double click on the following:  Hard Drive > System Folder > Preferences.  Locate “PrintMaster Preferences” 
and drag it to the Trash.

+ NOTE: If you wish to keep saved projects or address book (available only with Publishing Suite) information, then drag the Books 
and User folders to the desktop from within the PrintMaster folder located on the hard drive after the computer has rebooted from 
step six.

6. Extensions load into memory at system startup and actually alter the way the operating system works.  If they are incompatible 
with software, corrupt, or conflict with one another, then they can cause unexpected results.  The following directions will assist you 
in disabling Extensions with Systems 7.5.x or later:

A. Click on the Apple Icon in the upper left hand corner and select Control Panels > Extensions Manager.
B. At the top of the Extensions Manager window, there is a box marked “Sets”.  Click Sets and select the Save Set option.  For 
systems 7.6.x and OS/8 user’s, click File from the menu bar and select Rename Set.  When prompted, save the current set as 
“Standard” and click OK.  
C. Click the box marked “Sets” once more and select “All Off”.  For systems 7.6.x and OS/8 user’s, click Edit from the menu bar and 
select “All Off”.  This will disable ALL of your extensions.  However, CD ROM programs require a few extensions to be enabled.  
Please click on the following:  Apple CD ROM, Foreign File Access, QuickTime, QuickTime Power Plug (Power Mac’s and Power 
PC’s ONLY), and Printer extensions.  Under the Control Panel heading, click the following:  Apple Menu Options, CD ROM Control 
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Panels (if applicable), General Controls, Memory, Monitors & Sound, and Startup Disk.
D. After enabling the above mentioned extensions, click the box marked “Sets” and select the Save Set option. For systems 7.6.x and 
OS/8 user’s, click File from the menu bar and select Rename Set.  When prompted, save the current set as “Mindscape” and click 
OK.
E. Close the Extension Manager along with the Control Panel and Restart the computer.
F. After the Macintosh has restarted, reinstall the program as outlined in step 6 and try running PrintMaster Gold.
G. If PrintMaster Gold is running fine now and you wish to determine which extension was causing the conflict, then go back to the 
Extensions Manager located in the Control Panel, click on a few extensions so that they are checked, and repeat step E.  Repeat steps 
E-G until PrintMaster Gold no longer works.
H. When the program stops working, disable the most recent extension(s) you enabled and then restart the machine.  Make sure the 
program works.
I. Go back into the Extensions Manger located in the Control Panel, click on “Sets” and select the Save Set option. For systems 7.6.x 
and OS/8 user’s, click File from the menu bar and select Rename Set.  When prompted, save the current set as “Mindscape” and 
click OK.  You should be prompted to replace the existing set “Mindscape”.  Click the Replace button at this time.
J. To revert back to the “Standard” extension set, click on “Sets”, select “Standard”, and restart your computer. For systems 7.6.x and 
OS/8 user’s, click on “Selected Sets” and scroll up or down until the “Standard” set appears.  Select “Standard” and restart your 
computer.  When you want to use PrintMaster Gold, Click on the Apple Icon in the upper left hand corner, select Control Panels > 
Extensions Manager, and click on “Sets”.  Select “Mindscape” and restart your computer. For systems 7.6.x and OS/8 user’s, click on 
“Selected Sets” and scroll up or down until the “Mindscape” set appears.  Select “Mindscape” and restart your computer.

7. If you are experiencing printing problems, turn off the Background Printing option by clicking on the Apple Icon in the upper left 
hand corner and selecting Chooser.  From Chooser, select your printer and under Background Printing, select “Off”.  

+ NOTE: It is VERY important to verify with the printer manufacturer that you have the most current printer driver available.  This 
will not only rule out any possible conflicts between PrintMaster Gold and an outdated printer driver, but may enhance the output 
and functionality of your printer.

If the above suggestions do not resolve the problem,  please forward the responses to all of the above checks / verifications and 
please include the information requested under ”Before Contacting Technical Support…”  located at the end of the manual.

User's Guide Page  79 Die, 5. Jul 2016
Chapter 11: Macintosh Troubleshooting & Key Combinations



                        Key Combinations
Mouse and Keyboard Conventions
PrintMaster Gold supports the standard Macintosh mouse and keyboard Commandconventions. Use your mouse and the following 
keys to select menu items or to confirm commands.

Changing the Layout View
PrintMaster Gold makes it easy to alter the layout view to suit your editing needs. By choosing one of the options listed below you 
can zoom in to see the smallest details of your project, or zoom-out to see your entire project display on screen.

Layout viewing options can be easily accessed from the View menu with your mouse, or by pressing Command+V. Use the Up 
Arrow or Down Arrow to highlight the appropriate option, and press ENTER to select.

Percent View—This option allows you to increase or decrease the layout view level by fixed percentages. Press Command+V, P to 
choose one of the following view levels: 25%, 50%, 100% (normal), 200%, and 400%.
Fit in Window—This option allows you to adjust the layout view to fit your project page. Press Command+V, F to select this 
option.
Fit to Window Height—Select this option to adjust the layout view to fit the page height of your project page. Press Command+V, H
to select this option.
Zoom In/Zoom Out—This option allows you to zoom in or out by a defined percentage. This option is also accessible from the 
status bar.
Zoom Area—This option allows you to select the focus to zoom into.
1. Select this option and position the magnifying glass to the left and above the object you want to magnify.
2. Hold down the mouse button and drag the magnifying glass across and down the layout screen until the item of focus is enclosed 
in a box. Then release the mouse button.

General Editing Key Combinations
 Edit/Select All: Command-A 
 Edit/Cut: Command-X 
 Edit/Copy: Command-C 
 Edit/Paste: Command-V 
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 Edit/Cut: Shift-Del 
 File/New: Command-N 
 File/Open: Command-O 
 File/Save: Command-S 
 File/Print: Command-P 
 Edit/Delete: Del  
 Edit/Undo: Alt-Backspace 
 Edit/Undo: Command-Z 
 Edit/Redo: Command-Y 
 Zoom in:  “+” key on numeric keyboard 
 Zoom out: “-”key on numeric keyboard 
 Help: F1 
 Next window: F6 
 Previous window: Shift-F6 

When object is selected:
 Move object one pixel left:  Left arrow 
 Move object one pixel right:  Right arrow 
 Move object one pixel up:  Up arrow 
 Move object one pixel down: Down arrow 

Address Book
 Add New Name: Ins 
 Delete Current Name: Del 
 First Name: Home 
 Last Name: End 
 Previous Name: PgUp 
 Next Name: PgDn 

Text Editing
 Toggle bold text: Command-B 
 Toggle italic text: Command-I 
 Toggle underline text:  Command-U 
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 Move cursor left (*): Left arrow 
 Move cursor right (*): Right arrow  
 Move cursor up (*): Up arrow 
 Move cursor down (*): Down arrow 
 Left a word (*): Ctrl-left arrow 
 Right a word (*): Ctrl-right arrow 
 Beginning of line (*): Home   
 End of line (*): End 
 Beginning of text (*): Ctrl-Home  
 End of text (*): Ctrl-End 
  (*) hold shift to create/extend selection
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 PrintMaster Gold Technical Support
Before contacting Technical Support, please have the following information ready:
1. The version of PrintMaster you are using;
2. The make and type of computer you are using (68K or PowerPC);
3. How much memory you have available;
4. The operating system you are using;
5. The exact wording of any messages that appears on your screen;
6. A description of what happened and what you were doing when the problem occurred; and
7. A description of how you tried to solve the problem.

For Mindscape Technical Support in:
U.S.A.
   Online Services
   Internet-Web pages:
   Customer Services www.mindscapeservices.com
   PrintMaster www.printmaster.com
   Company Info www.mindscape.com
   Email: Support@mindscape.com
   Mindscape, Inc.
   800 Automated Support: 800-409-1497 24 Hours
   Fax: 415-897-5186 24 Hours
   Phone: 415-898-5157 8:30 AM - 5:00 PM Pacific Time
   Mail: Attn: Tech Support
    88 Rowland Way, Novato, CA 94945 
Europe
  Phone: 44-1-444-239-600 
  M-F 9.30-13.00 and 14.00-16.30
  Facsimile: 44-1-444-248-996 24 Hours
  Mail: Mindscape International, UK
  Priority House, Charles Ave.
  Maltings Park, Burgess Hill
  West Sussex RH15 9PQ, England
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  Online Services
  Internet–Web page: www.mindscapeuk.com
  Email: Uktechsupport@mindscape.com
Australia
 Phone: 61-2-899-2277
 Facsimile: 61-2-899-2348 24 Hours
 Mail: Mindscape International, Australia
 5-6 Gladstone Road, Castle Hill
 New South Wales 2154
 Online Services Email: 73414.470@compuserve.com
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